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Warning Labels

The following warning and caution labels are utilized throughout this manual to convey critical information
required for the safe and proper operation of the hardware and software. It is extremely important that all
such labels are carefully read and complied with in full to prevent personal injury and damage to the
equipment.

There are four levels of special alert notation used in this manual. In descending order of importance,
they are:

DANGER: This indicates an imminently hazardous situation, which, if not
avoided, will result in death or serious injury.

WARNING: This indicates a potentially hazardous situation, which, if not
avoided, could result in serious injury or major damage to the equipment.

CAUTION: This indicates a situation, which, if not avoided, could result in minor
injury or damage to the equipment.

NOTE: This provides supplementary information, emphasizes a point or
procedure, or gives a tip for easier operation

5 Copyright © 2022, Brooks Automation, Inc.



Guidance Dispense System
P/N: GDPO-DI-S0010, Rev 5.0.0, April 9, 2022

Table Of Contents

Guidance Dispense 8
System Introduction 8
Setup, Installation and Execution 10
Interfacing Your Robot to a PC 10
Setting the IP Address in Windows 11
Guidance Dispense Software Installation 14
Starting the Guidance Dispense Application 18
Hardware Introduction 22
Guidance Dispense Hardware Overview 22
Dual Control Air Dispenser 23
Dual Syringe Clamps 25
Arm-Mounted Camera and Light 26
PrecisePlace Robot Facilities End-Cap 27
Software Introduction 30
Guidance Dispense Software Overview 30
Dispensing Nodes, Node Types and Reference Frames 31
Dispensing Paths and Processes 34
Standard Web Page Format 35
Enabling Motor Power and Homing the Robot 37
Operator Control Panel -- Main Web Page 39
Editing Web Page 41
Edit -- Main Web Page 41
Process Editor Sub-Panel 43
Path and Node Editor Sub-Panel 44
Configuration Web Page 50
Configuration -- Main Web Page 50
Robot Motion and Safe Location Sub-Panel 52
Dispense Heads Sub-Panel 54

6 Copyright © 2022, Brooks Automation, Inc.



Brooks Automation
P/N: GDPO-DI-S0010, Rev 5.0.0, April 9, 2022

Global Frame Sub-Panel
Purge Setup Sub-Panel
Z-Search Sub-Panel
Teach Buttons Sub-Panel
Vision Sub-Panel
Virtual Pendant -- Main Web Page
Help -- Main Web Page

Step-By-Step Tutorials

56
58
59
61
62
64
67

68

Tutorials Introduction

Setup Tutorial 1: Enabling Power and Homing

Setup Tutorial 2: Manually Moving the Robot

Setup Tutorial 3: Teaching the Safe Location

Setup Tutorial 4: Teaching the Dispense Heads

Setup Tutorial 5: (Optional) Teaching the Purge Locations
Setup Tutorial 6: (Optional) Vision Interfacing and Calibration
Application Tutorial 1: Basic Application Example
Application Tutorial 2: Adjusting for Base Shifts and Rotations
Application Tutorial 3: Automatic Z Height Adjustment
Application Tutorial 4: Repeating a Path in a Grid Pattern
Application Tutorial 5:  Using Machine Vision

Sample Application Templates

Reference Information

Dual Control Air Dispenser Pneumatic Connections
Dual Control Air Dispenser Electrical Connections

Interfacing to PrecisePlace Robots

Trouble Shooting Guide

Guidance Dispense Common Error Messages

68
69
70
72
73
75
76
78
87
88
89
91
94

100

100
101
102

104

104

Copyright © 2022, Brooks Automation, Inc.



Guidance Dispense Guidance Dispense System
P/N: GDPO-DI-S0010, Rev 5.0.0, April 9, 2022

Guidance Dispense

System Introduction

Guidance Dispense (GD) is a set of hardware and software components that can be utilized to implement
a complete automated dispensing system. When these components are integrated with a robot and
combined with syringes and needles, they can automatically dispense adhesives, sealants and other
fluids along both simple and arbitrarily complex paths. Path programming is performed using simple
teach-and-repeat methods that can be augmented by machine vision to automatically correct for
deviations in part position and orientation.

Since dispensing encompasses an extremely wide range of requirements, Guidance Dispense has been
designed as a very open system that permits hardware and software components to be tailored for the
application. While GD has been designed for use with the PrecisePlace Cartesian robots, GD can be
employed with any robot that is controlled by a Precise Guidance Controller. As appropriate, the GD
software can be coupled with 3rd party hardware or the GD hardware could be employed without the GD
software. For simple dispensing applications, a user might purchase just the PrecisePlace robot with the
simple GD fixed syringe holder and the GD software and supply their own air dispenser, syringes,
needles and air plumbing.

In this manual, we assume that the full set of Guidance Dispense hardware and software components are
being utilized, but this is only done to simplify the manual. Please skip those sections of the manual that
do not apply to your system configuration.

The Guidance Dispense hardware consists of: a dual control air dispenser that can drive two syringes; a
simple fixed position syringe clamp; a second syringe clamp that moves on a vertical slide under
pneumatic control and includes a contact sensor; and an arm mounted camera that includes a variable
intensity ring light. The dual air dispenser includes two regulators for controlling the air pressure that
forces out the fluid in the syringes as well as two additional regulators for controlling vacuum for quickly
releasing the pressure on the syringes. The air dispenser housing includes buttons with lights as a
teaching aid and to indicate system status. The air dispenser solenoids, buttons and lights, pneumatic
clamp piston and contact sensor are all interfaced to the robot's controller to permit automatic operation.

The Guidance Dispense software is an open source package that executes on any Precise Guidance
Controller. In the case of the PrecisePlace robot, this software executes in a controller that is integrated
into the back of the robot's X-axis. The operator interface is implemented as a series of web pages that
can be viewed locally or remotely via a web browser. This software permits dispensing paths and
processes to be taught and executed without the need for programming. The graphical user interface
provides all of the tools for teaching straight and curved three-dimensional paths and controlling the
operation of the two syringes. The system includes an operator control panel and runtime that permits
paths to be played back while maintaining excellent speed control to enable consistent results.

8 Copyright © 2022, Brooks Automation, Inc.
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GD also supports PreciseVision for performing vision-guided path dispensing. This permits a camera
mounted above the work area or on the end of robot to locate objects or fiducial marks and to utilize the
detected positions and orientations to automatically update dispensing paths. This reduces the need for
complex fixtures and allows for a more flexible approach to dispensing.
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Setup, Installation and Execution

Interfacing Your Robot to a PC

All of the software and data necessary to teach and execute a dispensing process (with the exception of
machine vision) resides on the robot's controller. However, a PC is utilized as the graphical user interface
(GUI) for the Guidance Dispense software. Except for one-time system setup procedures, the only
application software required on the PC is a standard web browser. For the best results, it is suggested
that you use the following PC equipment for a non-vision system:

A 500 MHz or faster PC running a Windows XP or later system
Microsoft Internet Explorer version 6.x or later

A 10/100 Ethernet card

A standard Cat-5 Ethernet cable

If your system includes PreciseVision, the vision software will be executed on the PC. In this case, the
recommended equipment is the following (please see the PreciseVision manual for addition information
on cameras and installation of the PreciseVision software):

e A 2.3Ghz or faster Pentium 4 PC running a Windows XP or later system

e Microsoft Internet Explorer version 6.x or later

e Gigabit Ethernet (recommended and required for certain cameras), otherwise
100Mb Ethernet interface

e A standard Cat-5 Ethernet cable

e 512 MB of RAM

e Atleast 1 GB of space on the PC's disk

e A 2x CD-ROM drive interfaced to the PC or access to the Precise Support
website

To connect the robot’s controller to a PC, perform the following steps:

» Connect the robot's controller to the PC directly or via a hub or switch using the
appropriate cable as described above.

DANGER: Before operating your robot, ensure that the following

steps have been performed: (1) the robot has been properly
mounted; (2) all required safety interlocks have been installed and

tested; and (3) power has been connected. For the PrecisePlace
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robots, this information is provided in the “PrecisePlace 2300/2400
Robot, Hardware Introduction and Reference Manual”.

If you are utilizing a PrecisePlace robot, the Ethernet cable is plugged into either of the sockets on the
right end-cap of the robot as illustrated in the following:

Standard Cat-5
Ethemet Cable

» Set the IP address and subnet mask on the PC to be compatible with the controller.
By default the controller’s IP address is 192.168.0.1 and the subnet mask is
255.255.255.0. If you are not familiar with the procedure for changing the IP address
and subnet mask on the PC, please see the next section. Alternately, you can utilize
the Guidance Discovery application to set the controller's IP information to be
compatible with the PC.

For instructions on the use of the free Guidance Discovery utility, see the "Guidance Discovery" chapter
of the "Guidance Development Suite" section of the Precise Documentation Library.

Setting the IP Address in Windows

This section provides detailed instructions if you require assistance in configuring your PC’s IP address
and subnet mask to be compatible with the robot's controller. If you have already changed the IP address
and subnet mask on your PC, you can skip this section.

By default the Guidance Controller is factory configured with the IP address/subnet mask of 192.168.0.1
and 255.255.255.0. The PC must be compatible with this IP specification. For Windows users:

» Open the PC control panel by clicking Start > Settings >Network Connections

Copyright © 2022, Brooks Automation, Inc. 11
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» Right click on the icon for the Ethernet card that is connected to the controller
and select "Properties”.
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» Highlight "Internet Protocol (TCP/IP)" and click on the "Properties” button.
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» If your PC is using DHCP and is not compatible with the controller, you will need
to specify a compatible IP address and subnet mask. Click on the "Use the
following IP address" radio button and enter IP information that is compatible.
Once you have connected to the controller, you can change the IP address and
subnet mask of the controller to be compatible with your network.

» If your PC is using a static IP address you do NOT need to change the IP
address and subnet mask. Instead, click on the "Advanced" button.
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» Click on the "Add" button and enter in a compatible IP address and subnet mask.
For example you could use '192.168.0.200' and '255.255.255.0'.

» Click the OK to activate the changes.

Guidance Dispense Software Installation

If you wish to use the Guidance Dispense software package and it has not been pre-installed on your
robot's controller or if you wish to upgrade your GD software to a new version, this section describes the
software installation and upgrade process.

The GD software is an open source application that consists of a GPL "project” and a set of custom web
pages. This information is contain in a collection of disk files that must be loaded into the robot
controller's flash disk in the "/flash” directory. For simplicity, all of the required files are distributed in a
single compressed ".ZIP" file.

To successfully install a new version of GD, the following is required:

e A distribution copy of the GD software. This file is typically named
"GD_Version_xxx.zip".

e A copy of the Guidance Develop Suite (GDS) version 1.4 or later installed on
your PC. For this procedure, it is not necessary to purchase a licensed copy of
GDS since the installation utility will operate without a license.

e A PC with a suitable browser interfaced to the robot's controller via Ethernet.

e Atleast 1.5MB of free space available on the robot controller's flash disk.

e A copy of GPL version 1.3 or later executing on the robot's controller. GPL is the
motion control system software that is provided with each Precise Guidance
Controller.

To install the new Guidance Dispense software, perform the following steps.

» Copy the Guidance Dispense distribution file to your PC's hard drive and uncompress
the Zip file.

Recent versions of the Windows operating system provide built-in utilities for uncompressing Zip disk
files. Typically, if you right click on a Zip file, you will see a "Extract all" option. If your version of
Windows does not include this feature, you can obtain a free version of an UnZip utility from multiple sites
on the Internet.

14 Copyright © 2022, Brooks Automation, Inc.
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Once the GD distribution is uncompressed, you can execute the "Guidance Web Install Wizard" to copy
all of the files to the robot controller. This utility is part of the Guidance Development Suite. During the
installation of the application, if an existing installation of a web-based application is detected, the wizard
will prompt you to replace this with the new application.

» Launch the installation application by clicking Start > Programs > Precise
Automation > GDS x.x > Guidance Web Install Wizard .

44 Guidance Wab Install Wizard [- [Bx]

Welcome to the Guidance Web
Application Installation Wizard

Thies wizatd will instal the seected Guidance ‘web based
apphcation

To contrme. cick Next G Version 1.4.1.0, Apal 13, 2007

|Nm>|t-rm|

» Follow the instructions of this wizard to install the Guidance Dispense application.

» Provide the directory path and name of the file that contains the load instructions for
the installer. For GD, this file is named "GuidanceDispense.gwa" and will be located in
the top-level directory of the unZip'ed files.
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» Once the wizard is completed, restart the robot's controller to begin execution of the
Guidance Dispense application.

Starting the Guidance Dispense Application

As a configuration option for the robot's controller, each time the controller is restarted, the Guidance
Dispense Application can be automatically executed and the web pages redirected to the GD application
pages.

DANGER: Before operating your robot, ensure that the following
steps have been performed: (1) the robot has been properly
mounted; (2) all required safety interlocks have been installed and
tested; and (3) power has been connected. For the PrecisePlace
robots, this information is provided in the “PrecisePlace 2300/2400
Robot, Hardware Introduction and Reference Manual”.

» To access the Guidance Dispense Application user interface, start the robot's
controller by turning on the robot's AC power.

» On the PC interfaced to the controller via Ethernet, launch Internet Explorer and enter
the IP address of the robot's controller. By default, the controller's IP address is set to
192.168.0.1.

If Guidance Dispense and its web pages have been automatically started, the following web page will be
displayed within the browser. The background image is the GD Operator Control Panel. In the
foreground is a pop-up window that identifies the version of the GD software.

18 Copyright © 2022, Brooks Automation, Inc.
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If you do not see this web page, please refer to the Guidance Controller Setup and Operation, Quick Start
Guide for instructions for loading and executing a GPL project. The project to be loaded and executed
should be on the controller's flash disk and be named "Gdispense”. If you cannot locate the software or
if you would like GD to automatically start, execute the Software Installation process described in the
previous section and select the auto start options on the final screen. Once you are able to view the
startup pages for GD, continue with the remainder of this section.

» Click the "Continue" button to dismiss the Guidance Dispense version identification
pop-up window.

If this is the first time that the GD application is being executed, you will see the following error pop-up
that indicates that the "Safe Point" has not been taught. You will also see a number of errors listed in the
"Systems Messages" area that indicate that other data has not yet been defined.
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» Click the "OK" to ignore this error for now and select "No" when you are asked to
teach this position. The "Safe Point" will be discussed in later sections of this manual.

You should now see the following Operator Control Panel screen that indicates that the Guidance
Dispense application has been successfully started and is now operational.
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Hardware Introduction

Guidance Dispense Hardware Overview

This chapter describes how to operate and adjust the Guidance Dispense hardware components after
they have been mounted and interfaced to a robot and the Guidance Dispense software has been
installed on the robot's controller. For individuals who require an in-depth understanding of the this
hardware and for those who wish to configure a robot system with these components, detailed
descriptions of the GD hardware are provided in the Reference Information chapter.

The following picture illustrates a full-featured PrecisePlace 1300 (3-Axis XYZ) robot that includes all of
the Guidance Dispense hardware components. With the addition of loaded syringes with needles and a
PC interfaced via Ethernet, this equipment would be ready to apply to a vision-guided dispensing

application.

Dual Control ” Arm Mounted
Air Dispenser . - Camera w/ Light

iy
3 o

PrecisePlace

3-Axis Robot AC, Ethemet,

Air Pressure

— = Connectors

i —~

>l
sliding Syringe

Clamp w/ Sensor Fixed Syringe
Clamp

1

DANGER: The robot's controller and power supplies are located
beneath the X-axis cover. These units are open frame electrical
devices that have exposed unshielded high voltage pins, components
A and surfaces. In addition, the motor power supply provides 320VDC
volts to the motors and takes about 2 minutes to bleed down after
power is disconnected. AC power to the robot must be disconnected
prior to removal of the X-axis cover for any reason.
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Mounted on the Z-axis of the robot are: the dual control air dispenser; a sliding syringe clamp with a Z-
Contact sensor; a fixed position syringe clamp; and an arm-mounted downward looking camera with a
variable intensity ring light.

This system dispenses fluids by apply air pressure to a plunger within a syringe. This air pressure must
be provided by an external source that is connected to an air intake fitting mounted on the robot's right
end-cap. The air line is routed through the interior of the robot and the Z-axis E-chain and terminates at a
fitting in the right side of the air dispenser. The dual control air dispenser regulates and manages the
airflow and provides two output air lines, one for each of two possible syringes held by the two syringe
clamps.

If the system is equipped with the machine vision option, the camera can either be attached to a
stationary mount above the robot or can be mounted to the Z-axis of the robot as pictured above. The
benefit of a stationary mount is that a picture can be taken while the robot has moved away. The benefit
of an arm-mounted camera is that a higher resolution, smaller field of view lens can be selected and the
camera can be repositioned in the workspace as required.

If an arm-mounted camera is utilized, the DC power for the camera and the light are provided at the Z-
axis. The Ethernet cable that is connected to the camera is routed through the interior of the robot and its
signals are available on the robot's right end-cap.

In the next sections of this chapter, instructions on operating and adjusting the hardware components are
presented.

Dual Control Air Dispenser

The Dual Control Air Dispenser drives the air lines for the two syringes and the pneumatic actuator for the
sliding syringe clamp. In addition, this device has backlit buttons that greatly simplify teaching path
"nodes" and that display the system execution state when a path is being executed. The following picture
illustrates the key elements of this device.
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Syringe #1 Syringe #2
Air PSI VAC PSI VAC PSI  Air PSI
Alr Intake
Teach Buttons
FREE
LINE ARC
Syringe Electrical
Clamp Slide Harness
Air Line
Syringe #1 I Syringe #2

For each syringe, this device provides two pressure regulators: one to control the positive pressure that
forces the syringe plunger to dispense fluid and a second regulator that supplies air to a venturi device
that creates a vacuum in the syringe air line when the positive pressure is turned off. The vacuum assists
in backing off the syringe plunger to minimizing dribbling of the dispensed fluid.

Each of these regulators can be adjusted from 7 PSI up to 100 PSI. An adjustment screw is available
through a hole that is above each of the miniature pressure regulator meters.

NOTE: To avoid accidental changes in the pressure settings, the air pressure
screw adjustments normally have a locking nut engaged. To release the lock
nut, remove the cover of the air dispenser and loosen the nut.

The positive pressure for each syringe should be adjusted to provide the desired flow rate of dispensed
material. If the pressure is too high, the fluid will be too thick. If the pressure is too low, a continuous
bead will have unexpected breaks in the bead.

The three-backlit buttons on this unit provide a very convenient means for teaching a path. When the top
button is pressed, the robot is "free'd" to permit it to be manually moved to any desired position. For
robots like the PrecisePlace that have direct drive motors on the X & Y axes and very little friction, it is
quick and easy to manually push the robot and accurately position the syringe tip in free mode. When the
robot has been properly positioned, pressing one of the two lower buttons records either a node on a
straight line or arc path. These three buttons provide a very intuitive and rapid means for training even
complex paths.

The following table describes the use of the buttons and the interpretation of the button lights during both
path teaching and normal execution.
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Backlit Button During Teaching During Process Execution
@ Press to "Free" or "UnFree" all In dispense simulation mode,
Red (Free) | |[axes of the robot. Backlight is on |backlight is on when fluid should
when in Free mode. be dispensing.
Press to create and teach a Line
Green (Line) & |node. Baqkligh_t blinks Ba_cklight is on when a Line node
@ ' Imomentarily to indicate node being executed.
created.
Press to create and teach an Arc
Blue (Arc) &+ |node. Backlight blinks Backlight is on when an Arc node
< ® momentarily to indicate node being executed.
created.

o Backlights both on when
Blue & Green| g g [N-A executing a Dot or Pause node.

Dual Syringe Clamps

The Air Dispenser can control the air pressure for two syringes. Two syringes permit quick change over
when dispensing two types of fluids or when using two needle sizes. To accommodate two syringes, two
syringe clamps are provided. To avoid physical interference, one syringe clamp is mounted in a fixed
position on the robot's Z-axis and the second clamp is mounted on a pneumatically operated vertical slide
so its tip can be positioned below the fixed syringe when in use and moved up when not needed. Another
feature of the Sliding Syringe Clamp is that it is equipped with a sensor that can detect when the syringe
needle touches the work surface.

Air Lines From Air Dispenser

Z Contact
Sensor Cahle

Bi-Directional
Flow Control

Sliding
Syringe
Clamp
Fixed Syringe
Clamp {with
Z Contact Sample Syringe)
Sensor

As pictured above, the vertical positions of both the Fixed and Sliding Syringe Clamps can be adjusted by
sliding them up or down within the Z-axis T-slots before being tightened down. Both clamps have
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thumbscrews for retaining a syringe and can accommodate syringes up to 25 mm in diameter. For
smaller diameter syringes, a standard plastic insert can be obtained.

The Sliding Syringe Clamp has a total travel of 30 mm. When there is no air pressure, the clamp is pulled
into the down position by a spring. If the tip of the syringe mounted in this clamp touches a surface, the
clamp will rise up in the slide with a resistance generated by the spring. The Z-Contact Sensor will detect
this relative motion and this event will be captured by the robot's controller. Typically, the Z-Contact
Sensor is utilized for accurately setting the Z height at which to dispense a fluid. This can compensate for
manufacturing variations from part to part and can aid in ensuring that the dispense process yields high
quality results.

To ensure that the Sliding Syringe Clamp moves up and down quickly but without excessive impact, a Bi-
Directional Flow Control is mounted between the air supply line and the pneumatic actuator. Two knobs
are provided that control the air flow rate when the air pressure is applied or eliminated.

Arm-Mounted Camera and Light

If your system includes an arm-mounted camera and variable intensity light, the following picture
illustrates how these units can be attached to the Z-axis of the PrecisePlace 2300 robot.

Ethemet Cable

Camera DC
Power Cable

Blinking
Status Light
Light DC Ethemet
Power Cable Camera
) Variable
nght Oon/Off Inten5|t!|,r
Switch 8 Light
Intensity Khob

Please note that both the camera and the light mounting brackets can slide up and down in the T-Slot of
the Z-axis to permit these units to be positioned at the correct heights for an optimal camera field-of-view.

In order to operate, the camera requires that an Ethernet and DC Power Cable be plugged into the side
opposite from the lens. The DC Power Cable furnishes 12VDC. The Ethernet cable is used to receive
commands from the PreciseVision software and to transmit back digitized camera images.

Typically a manually operated lens that provides an f-stop and focus ring is mounted to the camera. To
avoid having these settings change during operation, the lens often has setscrews for fixing the positions
of the rings. These setscrews must be loosened in order to adjust either the f-stop or focus.
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The Ethernet camera includes a Status LED on the same surface as the Ethernet connector. This status

indicator is interpreted as follows:

LED State Camera Status
Off Camera is not receiving power
Steady Red Camera is not initialized

Slow Flashing Red

Camera initialization problem. Most likely indicates a
camera hardware failure.

Fast Flashing Red

Camera is too hot

Slow Flashing Blue

\Waiting for an IP address

Fast Flashing Blue

Ethernet cable disconnected (no link)

Steady Blue

IP address assigned, PreciseVision not connected to
camera

Steady Green

PreciseVision connected to camera, standard
operational state

Slow Flashing Green

Camera waiting for hardware trigger to take picture

Fast Flashing Green

Continuous acquisitions in progress, standard live
video state

Since the light normally remains on at all times, it is not operated by the robot's controller. There is a
switch (labeled in the picture above) that can be used to turn off the light even when the controller is
powered on. In addition, there is a small knob by the on/off switch that controls the intensity of the

light. Normally, the light intensity should be set bright enough to overcome variations in the ambient light
but not so bright as to create a reflected glare back into the camera lens.

For detailed information on programming the machine vision system, please see the PreciseVision

Machine Vision System, Introduction and Reference Manual.

PrecisePlace Robot Facilities End-Cap

If the Guidance Dispense hardware components are mounted on a PrecisePlace Cartesian robot, the

robot's Facilities End-Cap on the right side of the X-axis contains the plugs and connectors for AC power,
pneumatic air lines, Ethernet, and Digital 10 signals.
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12 Digital 8 Digital Front Panel /
Inputs  Outputs  MCP /E-Stop

10100 Mb
Ethemet

ﬂilt Ir_1take on f Off AC Input
Fittings Switch

To provide air pressure to the Dual Control Air Dispenser, clean, dry external air should be connected to
the LEFT air fitting. This air line is routed through the interior of the robot and exits at the Z-axis E-Chain
where it plugs into the Air Dispenser.

CAUTION: The maximum air pressure that can be conveyed by the
air lines through the robot is 75 PSI. Applying a pressure exceeding

A this level may disconnect interior connections or damage fittings or
hoses. If a higher pressure is required, an external air line should be
utilized.

If your system is equipped with an arm-mounted camera, the camera communicates with PreciseVision
via Ethernet. The Ethernet cable that plugs into the camera is routed through the interior of the robot and
is connected to the robot controller's integrated Ethernet switch. The two 10/100Mb Ethernet ports on the
End-Cap are also connected to the same switch. Therefore, either Ethernet plug can be used to interface
to the camera and the robot's controller. The second Ethernet port is provided as a wiring convenience.

If your system is equipped with a Precise Manual Control Pendant or an E-Stop box, these units can be
directly plugged into the "Front Panel / MCP / E-Stop" connector. The E-Stop button on these units will
be directly tied to the controller's hardware E-Stop inputs to ensure that the robot's motor power can be
quickly and reliably disabled.

The electric power required by the robot, its control electronics, the arm-mounted camera and its light,
and the Guidance Dispense hardware is all derived from the AC input line. The robot is equipped with
power supplies that can be utilized worldwide since they can accept voltages from 90 to 132 VAC and
180 to 264 VAC, 50-60 Hz. Turning off the green backlit On/Off switch on the end-cap will turn off power
to the robot and all of the mounted hardware.
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DANGER: The robot's controller and high voltage power supplies are
located beneath the X-axis cover. These units are all open frame
electrical devices that have exposed unshielded high voltage pins,
A components and surfaces. In addition, the motor power supply
provides 320VDC volts to the motors and takes about 2 minutes to
bleed down after power is disconnected. AC power to the robot must
be disconnected prior to removal of the X-axis cover for any reason.

Should you wish to obtain detailed pin-out information for the Digital Input, Digital Output or Front Panel
connectors, please see the PrecisePlace 2300/2400 Robot, Hardware Introduction and Reference
Manual.
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Software Introduction

Guidance Dispense Software Overview

The Guidance Dispense product includes an open source application program with a web-based
graphical user interface. The purpose of this software package is to permit the user to teach and execute
a sequence of operations that will move a syringe tip along a taught path while simultaneously sending
commands to the dual control air dispenser to force out fluid as required. This chapter introduces this
software's principal concepts, terminology and features. In additional, each of the web pages and the
function of their buttons and fields are described.

In the next chapter, this information is put to use in a series of step-by-step tutorials that illustrate all of
the basic operations of the system.

Within the Guidance Dispense software package, a complete dispensing operation is organized into a
dispensing "Process" that consists of one or more dispensing "Paths" that in turn consist of one or more

dispensing "Nodes".
-

@ Node

Using a simple web-based control panel, an operator can select and execute a taught dispensing
Process. A Process consists of a list of Paths that are performed in the sequence in which they are
defined within the Process. A Path defines a series of motions that control the position of a syringe

tip. The Path includes the specification for how fast the tool tip is to move when dispensing fluid and how
high above the start and end of the path the tool tip should be moved to start and end the motion
sequence.

A Path can be automatically repeated with its positions offset in X, Y, and Z. For example, a Path can be
automatically repeated at every position within an two dimensional array of parts.

Each syringe tip position within a Path is defined by a Node. A Node contains both the syringe tip
position as well as data specifying whether fluid should be dispensed while moving to this position. A
Path can contain thousands of Nodes if needed.
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The names of Processes, Paths and Nodes can consists of 1 to 43 characters. Names must start with
an alphabetic character or "_" and cannot be a single "_". The first character can be followed by any

combination of alphanumeric characters (a-z,A-Z,0-9) and " _". Names cannot contain space characters
(""). Upper and lower case letters are considered different so names are case sensitive.

When a Process is being executed, the data for the Process, its Paths and its Nodes are contained in
the robot controller's memory. To permanently retain this information, a copy of this data is stored in files
in the flash disk. The Guidance Dispense application automatically loads the required data files into the
controller's memory when a Process or Path is accessed for editing or execution.

To create and run a complete dispensing operation, you must first teach a series of Nodes to generate a
Path. Then you define the sequence in which the Paths are to be performed by specifying their order
within a Process. Finally, you execute the Process.

Dispensing Nodes, Node Types and Reference Frames

A dispensing "Node" is the most fundamental data element within the Guidance Dispense software. It
defines a single syringe tip position and includes information about whether dispensing is turned on or off
relative to this position. In order to specify the robot motion or action associated with a position, Nodes
are organized into Node Types. For instance, there is a Node Type that indicates that the syringe tip is
to move along a straight line to the position and a different Type to specify that a circular arc path is to be
followed.

The following example illustrates a Path that contains four Nodes. Step 1 moves the syringe tip to a
starting location. When this location is reached, dispensing is turned on. Next (Step 2), the tip is moved
along a straight-line path to a location that serves as the end of the line and the start of an arc. Finally,
the syringe is moved along an arc path (Steps 3 & 4), after which dispensing is turned off.

1. LineStrt -ON
2. LineEnd

3. ArcMid

4. ArcEnd -OFF

While GD could have been designed to define Node positions with respect to the base of the robot,
instead, Node positions are always defined relative to a "reference frame". A reference frame specifies
an important XYZ position and orientation that is significant to the dispensing application. For example, if
you wish to dispense fluid on to a plate, the position and orientation of a corner of the plate could be
defined by a reference frame. Then, instead of teaching positions relative to the base of the robot, each
Node point would automatically be taught with respect to the corner of the plate. If the plate were later
re-positioned or re-oriented, the positions of all of the taught points could be compensated by simply
updating the position and orientation of the reference frame. This is illustrated in the following picture that
depicts the four Node Path previously discussed.
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'

P

To simplify the use of a reference frame, by default, all Node positions are relative to the Global

Frame. A utility for quickly defining the position and orientation of this reference frame is included in the
GD software. If the value of the Global Frame is not taught, it will have a NULL value and all Node
positions will be with respect to the base of the robot.

If your system is equipped with PreciseVision, vision can dynamically compute and return a reference
frame that replaces all of the coordinates of the Global Frame except for its Z height. In the example
above, a camera could be used to locate the position and orientation of the corner of the plate. Then all
of the taught Node positions would be automatically adjusted to reflect the plate position and orientation
as determined by PreciseVision.

Since application requirements or fluid properties may require that dispensing be turned on at the start of
a motion or at the end of a motion or somewhere in between, GD supports a number of means for
specifying when dispensing signals should be turned on or off. Each Node can specify that a signal must
be changed a fixed distance or time from either end of its motion or as a percentage of travel. By default,
signals are changed at the end of each motion.

In the following table, each of the Node Types is described. For some types, like the Line Node, you
simply specify that you want a Line Node. However, when the Node is subsequently displayed, the
software automatically distinguishes whether a Line Node starts a sequence of straight-line motions,
ends a sequence or is in the middle of a sequence. This extra qualification is provided as a visual aid in
understanding what motions are to be performed.

Node Description
Type

Line Nodes define points between which the
syringe tip will be moved along a straight-line
path. A minimum of two Line Nodes are required

to defined a line path, the "LineStart" and the LineMid

Line "ITineEnd". In addition, an arbitrary number of_
Line Nodes can be placed between these points O = »O
and will be labeled "LineMid". LineStart LineEnd

A Line Node can be the first Node in a Path and
can be used to start an arc motion.
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IArc Nodes define a circular arc motion. An arc
motion must start with a Line or Pause Node
followed by an arbitrary number of pairs of Arc
Nodes. The minimum arc motion consists of a
Line Node followed by two Arc Nodes. Arc
Nodes cannot be placed after a Path Break or
Dot. The last Arc Node in a sequence is labeled
the "ArcEnd" and all of the intermediate points are ArcMid
labeled "ArcMid".

Arc  [The following rules apply: (e-\b

e Arc Nodes must be defined in pairs. LineStart ArcEnd

e The first Arc Node must be proceeded by
a Line or Pause Node.

e Arc Nodes cannot be placed after a Path
Break or Dot Node.

¢ Arc Nodes cannot be the first Node of a
Path.

If you wish to stop dispensing fluid and start
another dispensing sequence within a single Path,
as a programming convenience, you can insert a
Path Break Node. This Node will turn off
dispensing, automatically move above the
previous Node position by an amount "'mm Above
Path", and then move to a position "'mm Above

Path" above the next Node position. mm Ahove Path
Path )
Break |The following rules apply:
e There must be a Node before and after a LineEnd LineStart
Path Break.
e Cannot be the first or last Node in a Path.
e Cannot be two of these Nodes in a row.
e Cannot be moved to since it has no robot
position.
A Pause will stop the robot's motion at a Node for
a specified period of time. This is useful to form a Pause
Pause fill area that is along the Path. This Node can 5 O O
start or end a Path in order to delay before fluid is
dispensed or to delay until after the dispensing LineMid LineEnd

completes.
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/A Dot Node dispenses a single dab of fluid at the
Node position. The dispense tip is moved above
the Node position by the Path's "Approach” Approach Depart
height, moves down to the Node position and
Dot [turns on dispensing, delays for a specified time,
turns off dispensing, and then retracts to the
Path's "Depart" height. This Node can start or Dot
end a Path. In fact, a Path could consist of
several Dot Nodes and nothing else if required.

Dispensing Paths and Processes

A Path consists of a series of Nodes and can only operate a single syringe tip. A Path can contain as
few as one Node or can have thousands of Nodes to represent an extremely complex dispensing
pattern.

In addition to the list of Nodes, each Path includes specifications for the following functions and
parameters that can be uniquely defined for each Path:

e Z Height Search. At the first Node, GD can utilize the "Z-Contact" sensor or any
similar device to detect the actual height of the work surface. The difference
between the expected and actual height will then be automatically applied to
correct the Z values of all Nodes in the Path.

e X,Y,ZOffsets. The positions of all Nodes in the Path can be shifted by a fixed
offset in all three directions. This is useful for raising up the entire Path during
debugging and for adjusting the Path height following a Z-Search.

e 1D, 2D, 3D Pallets. A Path can be automatically repeated and indexed in 1, 2 or
3 dimensions. This is convenient for repeating a pattern or for executing the
pattern at each position in a 2D or 3D grid or pallet.

e Approach and Depart Points. At the start of a Path, the syringe tip can be moved
to a position above the first Node before moving to the Node (the "Approach”
point). Likewise, after moving to the final Node in a Path, the syringe tip can be
moved to a position above the final Node (the "Depart” point). Thisis a
convenient means for avoiding obstacles between dispensing patterns.

Approach Pt

Depart Pt
b [
- T .
-
-

First M-
Hode Final
Hode

Vision Process Reference Frame. At the start of the Path, a PreciseVision
process can be executed and the resulting position and orientation used in place
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of all but the Z height of the Global Frame to dynamically compensate all of the
Path's Node positions.

e Dual Syringe Speeds. Different syringe tip speeds can be specified for when
fluid is and is not being dispensed to optimize the system cycle time.

Within a Path, there are some restrictions on when the various Node Types can be specified. The
following are the rules that apply to all Paths:

e First Node. The first Node must be a Line, Point or Pause Type.

e Arc Nodes. Arc Nodes must always be specified in pairs and an arc path must
start with a Line or Pause Type.

e Final Node. The final Node cannot be a Break Path Type.

To permit a complete dispensing operation to be specified, multiple Path's can be combined into a
dispensing Process. A Process can be as simple as a single Path or can contain many different Paths
and even multiple references to the same Path. Paths are executed in the order in which they are listed
in a Process.

If your system includes two syringes and both syringes are utilized in the same operation, each syringe
must be controlled by one or more different Paths and these Paths must be specified in a Process in the
order in which they are to be executed.

To avoid driving the syringe into an obstacle as it moves to the Approach point for the first Path, a
Process always begins execution by retracting the robot to the Z height of a pre-defined Safe Location
and then moves horizontally to the Safe Location. Likewise, at the end of each Process, GD retracts
the robot to the Safe Location's Z height and then moves horizontally to the Safe Location and
terminates execution with the robot at this position.

Standard Web Page Format

The graphical user interface for the Guidance Dispense Application is composed of a series of web
pages. These web pages are stored on the robot controller's flash memory along with the application
software. They can be viewed either locally or remotely from a PC using Internet Explorer. Since both
the web pages and the application software are stored in the controller, there is never a problem of
inconsistencies between the user interface and the application software.

When GD begins execution in its normal mode of operation, the first web page displayed will appear as
follows:
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At the top of each web page, you will see the name of the software application, the top-level navigation
bar and a red “Disable Power” button.

WARNING: The "Disable Power" button is provided as a
convenience for turning off power to the robot’s motors. However, this
should not be confused with a hardwired E-Stop button. A hardwired
E-Stop button directly connects to the controller hardware and
guarantees that the motor power will be quickly disabled. The Disable
Power button relies upon the proper operation of software to function.

The navigation bar allows you to quickly switch between main web pages and access their functions. In
the case of the "Operator Control Panel" web page pictured above, all of the operations are available in a
single panel. For other pages, a list of sub-pages is displayed in a table on the left. Clicking on listed
topics in the left table displays sub-panels that present additional information.

The following briefly describes the contents of the pages associated with each of the tabs on the main
navigation bar. Each of these web pages and their sub-panels are described in greater detail later in this
chapter.
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Main Navigation Bar Summary

Selects, starts and stops the execution of a dispensing
Process. It also contains diagnostic and debugging aids
such as: buttons for enabling and disabling motor power,
buttons for reducing the speed of the entire Process, a
checkbox for disabling output of dispensing signals, and a
system messages display.

" Operator

Accesses a series of panels for creating, editing and
managing dispensing Processes, Paths and Nodes. Paths
can be created and individual Nodes can be added or
removed from a Path. Nodes can be edited including the
specification of their Type, position and dispensing
operation. Processes can be constructed by specifying the
Paths that they contain.

Presents a series of panels that define system configuration
- and parameter data. For example, this provides a step-by-
LSS [step process for defining the Global Frame and a panel for
configuring the digital 10 signals that control the air dispenser
and its teaching buttons.

Displays the Virtual Manual Control Pendant (VMCP) in a
_ separate web page window. The VMCP provides the same
DUEEEINEREEE [ functionality available from a hardware Manual Control
Pendant, i.e. the ability to manually move the robot in various
modes and display the current robot position.

Provides help information on the various web pages along
with tutorial examples.

As an aid in learning how to use the Guidance Dispense application, a number of web pages and panels

contain a help hot spot marked by 9 When you click on this icon, help information will be displayed in
a new window.

Enabling Motor Power and Homing the Robot

As a convenience, a number of the web pages provide buttons and fields for enabling/disabling power to
the robot's motors, displaying the current state of motor power, and for "homing" the robot. For example,
the Operator Control Panel has a "Robot Status" section that appears as follows:
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Robot Status

= |

When the "Enable" button is pressed, power to the robot's motors is enabled and any motor brakes are
released. The robot will normally be left in a position control mode and the motors will be maintaining the
current position of the robot until a command to move is generated. If the "Disable" button is pressed,
the red "Disable Power" button in the top of the page is pressed, an E-Stop button is pressed or an error
occurs, power to the motors will immediately be turned off.

DANGER: Before enabling power, ensure that the following steps
have been performed: (1) the robot has been properly mounted; (2)
all required safety interlocks have been installed and tested; and (3)
power has been connected. For the PrecisePlace robots, this
information is provided in the “PrecisePlace 2300/2400 Robot,
Hardware Introduction and Reference Manual”.

When power is enabled, the "System state" will transition from " Off: switch on wait" (which indicates
that the system is waiting for a switch to be changed to enable power) to "GPL Ready" (which indicates
that the robot is ready to operate in automatic mode) or "GPL Executing" (which indicates that a
dispensing operation is being run). Several other informational messages are possible such as those that
indicate that the robot is in manual control mode or that a hardware E-Stop button is being asserted.

Some systems are also equipped with a blinking power light. In the case of the PrecisePlace robots, a
yellow LED is mounted on the top of the Z-axis motor. When the controller is first powered on, this LED
will blink at a rate of about once per second. When motor power is enabled, the LED will blink at a rate of
4 times per second.

Before the robot can execute a dispensing Process or move in certain manual control modes, the robot
must be "homed" in addition to having its motor power enabled. Homing is the process whereby each
axis determines its position relative to an absolute O reference position. This permits the robot to
accurately repeat a taught motion sequence after AC power has been cycled and the controller is
restarted. Homing only needs to be performed once after controller power is restored no matter how
many times motor power is enabled or disabled.

When motor power is enable for the first time after the controller is restarted, the "Home Robot" button
should be pressed to home the robot. The homing method varies from robot-to-robot and from axis-to-
axis. Some axes are equipped with special homing sensors. Others simply rely upon a travel limit signal
or hard stop to reestablish the absolute position. In the case of the PrecisePlace robots, the X and Y-axes
are equipped with special Precise Pseudo Absolute Encoders that allow the absolute position to be
determined by making a very small 2-4 mm motion. For most robots, the homing process typically takes
a minute or so to complete.
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At the conclusion of the homing process, the "Robot Homed" field should indicate "Yes" and the robot
will be ready to be moved under manual or automatic control.

Operator Control Panel -- Main Web Page

The Operator Control Panel is displayed when the "Operator" tab in the Navigation bar is clicked. This
panel is used to select, start, stop and control the execution of a dispensing Process. Itis normally the
first web page that is displayed when this software package begins execution.
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This panel is divided into three major sections (System Messages, Robot Status, Select Process).

The "System Messages" section at the top of the panel contains a scrolling list of informational and error
messages that have been automatically generated. This section contains the following fields and buttons.

System Message Description
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/A read only text box that displays all system and application
messages. The most recent message is displayed on the top

line. Please see the Trouble Shooting Chapter of this manual for a
description of common error messages and output generated by
Guidance Dispense. Please see the Precise Documentation
Library > Controller Software > Software Reference > System Error
Codes for a description of the complete list of error messages that
can be generated by the robot control system.

Clears all messages displayed in the "Message box". This is
Clear message convenient for deleting old messages that can be confusing if
attention is not paid to the message time stamp.

Message box

The "Robot Status" section in the middle of the panel contains items for controlling motor power and robot
homing.

Robot Status Description

System State
Robot Homed
Enable
Disable
Home Robot

Please see the section on Enabling Motor Power and Homing the
Robot for a description of these buttons and fields.

The "Select Process" section at the bottom of the panel permits the operator to select the dispensing
Process that they wish to execute and to start and stop its execution. This panel also includes aids for
debugging and testing a Process.

Select Process Description
Displays a list of Processes that are currently defined. Before the
<Process list> 'Start" button is pressed, a Process must be selected in this
window.
Begins execution of the Process selected in the <Process
Start List>. Before execution can commence, robot motor power must be

enabled and the robot must be homed.

Immediately stops any process currently being executed. The

Stop dispense output control signals will be turned off to prevent
unintentional dispensing.

Displays a pop-up window that can move the robot to the
designated "Purge" position and turn on the specified dispense
head(s). This is used to verify that the heads are working or to clear
the needles. Please see Purge Setup for additional information.

If checked, disables the operation of the dispenser syringes when a
Process is executed. The dispenser output signal is re-directed to
[ ] Disable Outputs [the "Free" teach button light on the Air Dispenser. This mode is
useful for test running an entire dispense Process without
dispensing any fluid.

Purge
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Reduces the speed of all robot motions to allow a Process to be
System Speed run slowly for diagnostic and debugging purposes. Normally, this
speed should be set to 100% for normal operation.

Editing Web Page

Edit -- Main Web Page

The Edit page is displayed when the "Edit" tab in the Navigation bar is clicked. This page provides a
series of panels for creating, editing and managing dispensing Processes, Paths and Nodes.
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When this page is first displayed, the right panel presents a brief summary of the relationship between the
dispensing elements and the steps for creating a complete operation. The three lists on the left select the

data to be edited and provide convenient access to buttons for enabling motor power and moving the
robot.

The contents of the Editing list is as follows:
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Editing Description

Displays in the section to the right, the panel for creating, modifying
Process Editor and deleting dispensing Processes. A detailed description of this
panel is provided in the following section.

Displays in the section to the right, the panel for creating, modifying
Path Editor and deleting dispensing Paths and Nodes. A detailed description
of this panel is provided in a following section.

The Robot Status list contains a variation of the motor power control and homing items available in the
Operator Control Panel. In addition, it provides buttons for assisting in manually positioning the

robot. This list and the following list are very useful for defining and touching up Paths and Node
positions.

Robot Status Description

<System State>
Homed

Please see the section on Enabling Motor Power and Homing the

Epable Robot for a description of these buttons and fields.
Disable
Home Robot
Places the robot back into computer control mode (to permit
Comp automatic execution) if the robot is currently in manual control
mode.
Places the robot into manual control mode and "free's" all of the
Free axes. Free'd axes can be positioned by pushing the robot and

manually moving it into position.

Immediately decelerates and stops the robot if it is in motion and
turns off all dispenser output signals. Then, the operator is
prompted to determine if the robot should be retracted and moved
to the Safe Location.

Stop Immediate

The Robot Move list provides a number of convenient means for repositioning the robot and purging the
syringes.

Robot Move Description
Opens up a miniature version of the Virtual Manual Control Panel in
Mini Jog a separate window. This panel can remain open while jogging and

teaching points in the editor.

If a Process is not executing, moves the robot in the world Z
Retract Arm direction to the Z height of the Safe Location. This is convenient for
clearing an error or debugging an operation.

If a Process is not executing, moves the robot in the world Z

Move Safe direction to the Z height of the Safe Location followed by a
horizontal motion to the Safe Location.
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Displays a pop-up window that can move the robot to the
designated "Purge" position and turn on the specified dispense
head(s). This is used to verify that the heads are working or to clear
the needles. Please see Purge Setup for additional information.

Run Purge

Process Editor Sub-Panel

When the "Edit" tab is clicked and the "Process Editor" button is pressed, the panel pictured below is
displayed in the bottom right of the Edit page. This editor allows multiple dispense Paths to be organized
into a Process. A Process can contain any combination of Paths and multiples references to the same
Path. Once a Process has been created, it will automatically be displayed in the process list of the
Operator Control Panel.

A process is a st of path to execute in sequence.
Balow, build a list of paths to run in the order they
should b digpansed,

Process Files

Process List

The "Process Files" list displays the names of the Processes that have already been created. Each
Process is preserved in its own file on the flash disk. Guidance Dispense automatically loads the data
for a Process back into the controller's memory when it is required for editing or execution. However,
modified Process data is only stored to a disk file when an explicit command is received to avoid
replacing permanent settings with temporary trial data.

Process Files Description
Creates a new Process both in memory and on the flash
New disk. Once created, Processes must have Paths assigned to
them.
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IAfter confirmation, deletes the highlighted Process file from
memory and the flash disk.

Executes the highlighted Process. This is the same operation

Run performed by the Operator Control Panel. *Note - this operation
requires that the Process be saved prior to execution.

If checked, disables the operation of the dispenser syringes when a
[ ] Disable Dispense|Process is executed. This is useful for running an entire dispense
Process without dispensing any fluid.

Remove

When a Process is selected in the "Process Files" list, the Paths assigned to the Process are displayed
in the "Process Contents" display. New Paths can be added to the selected Process using the
"Available Paths" list.

Process List & Description
Available Paths

Inserts the Path highlighted in the "Available Paths" list into the
Process above the highlighted Path in the "Process Contents".
IAppends the Path highlighted in the "Available Paths" to the end of
the "Process Contents" list.

Removes the Path highlighted in the "Process Contents" from the
Remove list. This does NOT remove the Path file from memory or the flash
disk, it just removes a reference to it in the Process.

Saves any changes made to the currently selected Process to its
Save flash disk file. Once saved, you can use the "Run" operation or the
Operator Control Panel to execute the Process.

Insert

Append

Path and Node Editor Sub-Panel

When the "Edit" tab is clicked and the "Path Editor" button is pressed, the panel pictured below is
displayed in the bottom right of the Edit page. The Path Editor provides the tools for creating, managing
and modifying Paths and their Nodes.
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The "Path Files" list displays the names of the Paths that have already been created. Each Path is
preserved in its own file on the flash disk. Guidance Dispense automatically loads the data for a Path

back into the controller's memory when it is required for editing or execution.

However, modified Path

data is only stored to a disk file when an explicit command is received to avoid replacing permanent
settings with temporary trial data.

Path Files

Description

New

Creates a new Path both in memory and on the flash disk. Once
created, Paths must have Nodes added to them. This function
displays a pop-up that prompts whether a new Path is simply to be
created (which is assigned a single Node) or whether a new Path
should be created and a series of Nodes taught. In teach mode, the
user can create and define the position for Nodes by clicking a pop-
up button or using the teach buttons on the Air Dispense unit.

Remove

IAfter confirmation, deletes the highlighted Path file from memory
and the flash disk.

Copy

Makes a copy of the selected Path. The operator to enter a new
Path name.

\Verify

Performs a verification check on the selected Path. This test
includes verifying that all of the Nodes in the Path satisfy the rules
and that the Z height of all Nodes is sufficiently high. This function
is provided to allow Paths to be pre-checked since this test is

automatically performed when a Path is executed.
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Executes the highlighted Path. The operator is prompted to run the
entire Path or one step at a time. The step-by-step mode allows
Run Path individual line/arc operations to be executed along the Path and
assists in debugging. In step-by-step mode, the dispenser output is
automatically disabled.

If checked, disables the operation of the dispenser syringes when a
Path is executed. The dispenser output signal is re-directed to the
[ ] Disable Dispense['Free" teach button light on the Air Dispenser. This is useful for dry
running a Path and fine-tuning Nodes while receiving visual
feedback on the dispensing commands.

The "Global" section of this panel specifies parameters that affect the entire Path and are not specific to a
particular Node.

Global Description

Specifies the speed (in mm/sec) of the syringe tip while it is
dispensing fluid.

Defines the transition speed (in mm/sec) of the syringe tip while it is
Trans Spd moving between Nodes. Anytime that fluid is not being dispensed,
this speed is applied to optimize the overall cycle time.

Defines distance (in mm) that the dispensing head will moved
IApproach/Depart  |above the first and last Node positions when performing the
dispensing Path.

Enables the Z-Search mode. If "use probe" is selected, prior to
performing the dispense path, the robot will move to the first Node
in the path and search down. When the surface is detected, the "Z"

Dispense Spd

Search height of the dispense Path is automatically adjusted (based on the
'Z-Search" settings). This operation is only performed once per path
cycle.

Specifies the dispense head that will be used. This is important as it
determines the digital output that is operated to dispense fluid. In

Tool i : X . . .
addition, the proper syringe dimension and mounting offset is
applied based on the definition of the Dispense Head.

Defines a fixed offset that is applied to the position of each Node in

Offset X, Y, Z the Path when the Path is executed. It is also applied during

teaching or editing of the Path points. This operation allows fine
tweaking of a Path without having to edit individual path points.

The "Pallet" section permits a Path to be repeated in a 1, 2 or 3 dimensional rectangular grid that is
relative to the Path's reference frame. This can be utilized to repeat a dispensing pattern at each position
in a pallet.

Pallet Description

Defines which dimensions will be repeated and how many times
X, Y, Z ldx (1-n) they will be repeated. By default these values are all set to "1" to
indicate that repeating is NOT enabled. If a Path is to be repeated
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on a standard pallet, these values represent the number of rows
(X), columns (Y) and stacks (Z) in the pallet. In addition to setting
these value, the "Pitch" must also be properly set.

X, Y, Z Pitch (mm)

Specifies the distance (in mm) between adjacent rows, columns or
stacks.

Order

Selects the order in which the 3 dimensions will be indexed. When a|
pallet is enabled (indicated by having the 'ldx' values > 1) an order

of operation is applied based on this setting.

The "Vision" section enables PreciseVision to dynamically compute a reference frame that replaces all of
the components of the Global Frame except for its Z height. When enabled, a user defined

PreciseVision Vision Process is automatically executed at the start of the Path. If PreciseVision cannot
locate the reference frame or if a visual part inspection indicates that a part is not acceptable, Path

execution will be terminated with an error.

Vision

Description

[ ] Use Vision

If checked, enables using PreciseVision to generate the Path's
reference frame.

[ ] Index Camera

If checked, automatically indexes the position of an arm-mounted
camera based on the "Pallet" settings. This allows a grid of loosely
fixtured parts to be addressed using a single Path pattern. Each
time the pallet is indexed, the arm-mounted camera will be
positioned to the next pallet location for the picture point and the
vision system will be called again.

If not checked and a pallet is enabled, PreciseVision will only be
called at the first pallet location. All subsequent pallet Paths will
use the original vision frame. This is useful for fixed mounted
cameras or parts that are fixed accurately in a tray but where the
tray is placed in the robot's work area in a coarse position.

Process Name

Defines the required name of the PreciseVision Vision Process that
is executed to determine and return the Path reference frame.

Vision Tool Name

Optionally defines the name of a vision tool that is part of the
PreciseVision Vision Process. By default, the last tool executed by
PreciseVision computes and returns the value of the required
reference frame. However, if a tool name is specified in this
parameter, its reference frame value is returned and utilized
instead.

Picture Location

(X,Y,Z,yaw,pitch,roll)

Defines the position where the robot should be moved to prior to
calling PreciseVision to execute the Vision Process. If all of the
components are set to "0" (the default), then the picture point
stored in the Vision Configuration is used instead. This picture point
is taught relative to the Global Frame. |If this position is specified,
its Z component is forced to match that of the original camera
calibration point defined in the Vision configuration.

Record (button)

Records the Picture Location where the robot must be moved to
prior to executing the Vision Process. This function automatically

looks at the position stored in the Vision Configuration and sets the
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new point to the same Z height. For arm-mounted cameras, it is
important that the Z height be constant to maintain the same field-
of-view and scaling.

Moves the robot to the Picture Location and performs the Vision
Process. This assists in debugging the Picture Location and Vision
Process. This must be executed prior to manually teaching Path
points relative to the vision-generated frame of reference.

Moves the robot back to the Picture Location. This is useful for
debugging the Vision Process in PreciseVision.

Perform (button)

Move To (button)

The "Path Points" section displays and manages the list of Nodes defined in the currently selected
Path. Specific data for the Node selected in this list is displayed in the "Selected Path Point" section.

Path Points Description

Provides a scroll list of all the Nodes defined in the selected
Path. This list also displays any errors in the Path. If any error
is detected, the list is displayed in Red. The Node causing the
problem includes a "*" prior to its name. Use the "Verify"

Path Point List View operation to get more descriptive details of the problem.

\When the Node list display is generated, Node Types are
automatically assigned more descriptive names based upon the
Node rules. For example, the first ARC Node will be labeled
"ArcMid" and the second will be labeled "ArcEnd".
Insert/Append/RemovelAllows Nodes to be easily added and removed to/from the
(buttons) selected Path.

Allows advanced Node add/remove operations. These include
"Copying" and "Removing" a range of Nodes and the ability to
IAdvanced add more Nodes using the teach buttons on the Air Dispenser.
These operations make is very easy to duplicate a section of a
Path or remove unwanted areas of a complex Path.

Records the current position of the robot relative to the current
reference frame and stores the value in the select Node.
Simultaneously sets or increments a position component (X, Y,
Z, Yaw, Pitch, Roll) for a range of Nodes. This is very useful for
Set Value adjusting all or part of a Path to have the same "Z"

value. Alternately, an offset can be added to a position
component for a range of Nodes.

Moves the robot directly to the selected Node position taking into
account the current reference frame. If no special frame is in
effect, the Global Frame will be utilized. If the Path is relative to
vision results, the position will be relative to the last generated
Vision Process reference frame.

Record (button)

Move To (button)

*Note - care should be taken when clicking this button. If the
Global Frame has been re-taught improperly or Dispense Head
dimensions or mounting have been changed, it could lead to
needle damage.
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Extend/Retract
(buttons)

Extends or retracts the selected dispense head if it is equipped
with a pneumatic slide. These buttons provide a convenient way
to operate the head digital 1/O.

The "Selected Path Point" section displays the detailed information for the Node that is selected in the

"Path Points" list.

Selected Path
Point

Description

X,Y,Z,yaw,pitch,roll

Displays the coordinates of the selected Node relative to the Path's
reference frame. These values represent the relative position and
orientation of the Node with respect to either the Global Frame or
the frame generated by PreciseVision depending on the Path
settings.

Type

Displays the Node Type for the current Path point.

Dispense

Selects if the dispense operation is turned on/off/nochange.
Nochange will leave the current state of the output for the dispenser
unchanged. On/Off will turn on or off the output of the dispense
head.

Mode

For Line and Arc Nodes, specifies when the dispense operation
change defined by the "Dispense” parameter is put into effect.

e %Start/End - Change occurs at a percentage of the
distance from the start or end of the motion to the Node.

e mm Start/End - Change occurs at a distance in mm from
the start or end of the motion to the Node. "mm End" is the
default setting and the most common case.

e Sec Start/End - Change occurs at a fixed time in seconds
from the start or end of the motion to the Node.

For Pause and Dot Nodes, this parameter is ignored.

For Path Break Nodes, this parameter indicates the "mm Above"
height.

Value

Defines the decimal number that is the numerical portion of the
"Mode" specification. For example, if the Mode is "mm Start", this
parameter defines the distance in mm from the start of the motion to
the Node when the dispense operation change takes place.

Save Path (button)

Saves the currently selected Path to the flash disk. The user can
make changes to a Path without saving. Once debugging is

completed, use this button to permanently alter the Path.

NOTE: All changes to a Path will be lost if a different Path file is selected
before the changes are saved to the flash disk. Anytime a Path is modified a
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the file on the flash is NOT up to date.

"Path modified" box will be displayed next to the "Save Path" button to indicate

Configuration Web Page

Configuration -- Main Web Page

The Configuration page is displayed when the "Configuration" tab in the Navigation bar is clicked. This
page provides a number of utilities for defining system configuration and setup parameters. For example,
this page has a step-by-step process for defining the Global Frame and a panel for configuring the digital
IO signals that control the air dispenser and its teaching buttons.
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When this page is first displayed, the right panel presents a brief summary of important setup processes

that should be executed. The three lists on the left select the configuration panel to be display and

provide convenient access to buttons for enabling motor power and moving the robot.

When a button in the "Configuration” list is clicked, the corresponding panel is displayed to the right. In
the following sections, the operation of each of these panels will be described in detail. The following

table contains a brief summary of these panels.

Configuration

Description

Robot Motion

Defines the "Safe Location", robot speeds used during various
motions and the minimum Z height for all automatic motions.

Dispense Heads

Defines the mounting position and dimensions of the two dispense
heads (syringe tips) and the digital 10 signals that control their
operation.

Global Frame

Defines the reference frame that all Node locations are defined with
respect to by default.

Defines the position to which the robot is moved to purge a syringe

Purge Setup and the duration of the purging operation.
Defines the parameters for searching for the Z height of a surface
Z-Search using the "Z-Contact Sensor". The computed correction in the Z

height will be applied to all Node locations in a Path.

Teach Buttons

Defines the digital 10 signals assigned for the teach buttons on the
Single/Dual Control Air Dispenser.

Defines the interface parameters necessary for using PreciseVision
with GD. This includes the vision PC's IP address and the location

Vision to which the robot is moved to take a picture during the camera
calibration process.
Launches a new web window and displays the standard GUI for the
. Precise Guidance Controller. Access to this interface is provided
Guidance Web

for completeness and should not be required during normal
operation of the system.

The Robot Status list contains a variation of the motor power control and homing items available in the

Operator Control Panel. In addition, it provides buttons for assisting in manually positioning the
robot. This list and the following list are very useful for manually moving the robot to define key locations
necessary for the configuration operations.

Robot Status

Description

<System State>

Homed

Enable

Please see the section on Enabling Motor Power and Homing the

Disable

Robot for a description of these buttons and fields.

Home Robot

Comp

Places the robot back into computer control mode (to permit
automatic execution) if the robot is currently in manual control

mode.
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Places the robot into manual control mode and "free's" all of the
Free axes. Free'd axes can be positioned by grabbing the robot and
manually moving them into position.

Immediately decelerates and stops the robot if it is in motion and
turns off all dispenser output signals. Then, the operator is
prompted to determine if the robot should be retracted and moved
to the Safe Location.

Stop Immediate

The Robot Move list provides a number of convenient means for repositioning the robot and purging the
syringes.

Robot Move Description

Opens up a miniature version of the Virtual Manual Control Panel in
Mini Jog a separate window. This panel can remain open while jogging and
teaching points in the editor.

If a Process is not executing, moves the robot in the world Z
Retract Arm direction to the Z height of the Safe Location. This is convenient for
clearing an error or debugging an operation.

If a Process is not executing, moves the robot in the world Z

Move Safe direction to the Z height of the Safe Location followed by a
horizontal motion to the Safe Location.

Displays a pop-up window that can move the robot to the
designated "Purge" position and turn on the specified dispense
head(s). This is used to verify that the heads are working or to clear
the needles. Please see Purge Setup for additional information.

Run Purge

Robot Motion and Safe Location Sub-Panel

When the "Configuration" tab is clicked and the "Robot Motion" button is pressed, the panel pictured
below is displayed in the bottom right of the Configuration page. This panel defines the "Safe Location",
robot speeds used by various motions and the minimum Z height for all automatic motions.
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Bobot Motion

| Safe Location |

The safe pointis where the robot will move o
befare and after performaing a dispenze
PrOCEss.

Teach Safe Pont I Move Safe Point |
| General Motion Settings ]

Settings that are used during moving
between paths and back to the safe location.

Run Speed (% max) [ 30
Edit Speed (% max) [ 10
ApcelfDecal (% max) W
Accal Ramp (seconds) [ o1

[ Path Verify Test 1
Each path point should be taught above the
global frame of reference (including any
offset). This value is the value used to check
against, Set to large negative to disable,

Z path node test 0 M

Save

The Safe Location is a position where the robot can be moved to be clear of all obstacles in the work
cell. When a Process begins execution, the robot is always moved to the Safe Location before going to
the first Node. After the motion to the last Node, the robot is returned to the Safe Location before the

Process terminates.

Motions to the Safe Location are always performed in two steps:

e Retracts the robot to the Z height specified by the Safe Location.

e Moves horizontally to the Safe Location.

NOTE: The Z height of the Safe Location is particularly important since the robot
moves to the Safe Location by first retracting to this Z height and then moving
horizontally to the Safe Location. Also, other operations, like Purging, also use
this Z height for moving safely through the workspace.

Safe Location

Description

Teach Safe Point

Records the current location of the robot as the value of the Safe
Location.

Move Safe Point

Moves the robot to the safe point. This is convenient for placing the
robot into a known location.
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The "General Motions Settings" contains speed and acceleration specifications that apply when the
system is moved automatically during training (e.g. Purge and Move Safe operations) and when the robot
is moving between Paths. While executing a Path, the transit and dispensing syringe tip speeds are
explicitly specified as parameters to the Path.

General Motion Description
Settings

Defines the speed (as a percentage of the robot's maximum
nominal speed) of motions when executing a Process but not
following a Path.

Defines the speed (as a percentage of the robot's maximum

Edit Speed (% max)jnominal speed) for automatic motions performed during training and
debugging, e.g. Purge motions and moving to the Safe Location.
Defines the acceleration and deceleration (as a percentage of the
robot's maximum nominal values) for all motions except when

Run Speed (%
max)

)Accel/Decel (%

ma) following a Path.
IAccel Ramp Defines the acceleration/deceleration ramp times (s-curve profiling)
(seconds) for all motions except when following a Path.

Whenever the robot is moved automatically both during training and when executing a Process, the
destination of each motion is tested to ensure that it is not too low relative to the Z height of the Global
Frame. This is a precaution to prevent a syringe tip from being inadvertently driven into the deck.

Path Verify Test Description

Defines the minimum Z height relative to the Global Frame for the
destination of all automatic motions. Any motion that attempts to go
below this value will be terminated and flagged as an error. To
disable this test, a large negative values should be entered.

Save Updates the motion settings saved on the flash disk.

Z path node test

Dispense Heads Sub-Panel

When the "Configuration" tab is clicked and the "Dispense Heads" button is pressed, the panel
pictured below is displayed in the bottom right of the Configuration page. This panel defines the mounting
position and dimensions of the two dispense heads (syringe tips) and the digital 10 signals that control
their operation.
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Dispenes Haads

Up to 2 dispenser heads can be mounted on the end of the arm. Each one can have a
unigue tool offset that is applied dunng teaching and playback.

Initial Setup Steps:
1. Teach nitial reference point using dispense ‘Head 1° and click 'Rec Reference’.
2. Move robot so Head 2 is at the reference point and click "Rec Offset 2.

Mlln:get-diﬁnen;er head to initial reference point and dick 'Rec
Cffse

After Changing Tip:

Yaw Piteh Roll
Rec BEeference I o o a Move Ta
Hesd 1 Yaw Pirch Roll

Fec Offzet 1 [ o I [+] [ 0 | (1] Move Ta
Extend Signal =13 Dispense Signal a7

Euhn-:il Fetract M FF l
¥ Z

Head 2 Waw Blech Eoll
Rec Offees 2 | [ 0 | 0 | a | o [ o Move To
Extend Signal 0 Dispense Signal 38

Emnd| Retract oN OFF |
Save

It is permissible to teach a Path and repeat the Path without knowing the dimensions or mounting
position of the syringe heads. But, if GD does know this information, if a syringe and needle size changes
or if a syringe needle bends, GD can automatically adjust the robot motions so that the new syringe tip
will follow the previously taught Path. In addition, if two syringes are used, the Nodes taught with one
syringe can be easily repeated by the other syringe.

To simplify the training of the dimensions and mounting of the syringe tips, you must select a "Reference
Point" in the work cell that does not move. Then, to teach the dimensions and mounting of a different
syringe tip, you only need to move that tip to the same Reference Point and click a button. GD will
compute the required information and will automatically put this data into effect each time the syringe tip
is selected.

NOTE: Once the Reference Point value is taught, it should not be changed. If
this value is re-taught with a syringe tip that is a different size or is mounted in a
different position on the robot, it will alter the result of any syringe tips that are
taught with respect to this new Reference Point and any formerly taught Path's
will be incorrect.

Reference Description

Records the value of the Reference Point. Dispense head #1 must
be used to teach this location.

Rec Reference
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X, Y, Z, Yaw, Pitch, [Displays the coordinate values of Reference Point. _These should
Roll not be altered once they are taught.

Displays a pop-up window that can move a syringe tip to the
Reference Point or to a position above this location.

Move To

Once the Reference Point is established, the dimensions and mounting of either dispense head can be
taught or re-taught simply by moving the desired syringe tip to the Reference Point and pressing the Rec
Offset button. The following data pertains to each of the dispense heads.

Head 1 or 2 Description

Computes the dimension and mounting data for a dispense head
when the syringe tip is positioned at the Reference Point.

X, Y, Z, Yaw, Pitch, |Displays the computed coordinate values for the dispense

Roll head. Initially, the values for head #1 will all be close to 0.
Displays a pop-up window that can move a syringe tip to the
Reference Point or to a position above this location.

Defines the number of the Digital I/O signal that controls the
Extend Signal extension and retraction of the sliding syringe clamp. When this
signal is asserted, the slide is extended.

Defines the number of the Digital I/O signal that applies air pressure
to the syringe. When this signal is asserted, fluid is dispensed.
Turns the Digital I/O signal that controls the syringe slide off or on.

Rec Offset

Move To

Dispense Signal

Extend/Retract This allows for debugging the dispense head locally on this page.
/Actuates the dispense signal. This operation allows for debugging
On/Off : !
the dispense fluid.
Save Saves all dispense head information to the flash disk.

Global Frame Sub-Panel

When the "Configuration" tab is clicked and the "Global Frame" button is pressed, the panel pictured
below is displayed in the bottom right of the Configuration page. This panel specifies the reference frame
that all Node locations are defined "with respect to" by default.
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wGladal Frama
The global frame is what path points are taught
relative to, Click the Teach Frame Wizard” button
below to walk through teaching the frama.

‘When teaching the frame paints, it IS impartant
o follow the nght hand rule, These points
describe a plane where the Cartesian "Z2" axis is
pointing up.

Teath Frame Wizard

% ¥
Teach Ogin | [ 3707414 [ 2293075 [ - Movs To
Tesch POK |[ 3728528 | 909304 [ - 0 Move To
Takch POY ]| saozTee | zanzmiz | - 180 Mava T

% ¥ z
Frame Value zzsa07s [ - | TR

Node locations are always defined with respect to a reference frame. If vision is being used, the vision
results dynamically supersede all of the coordinates of the Global Frame except for its Z height.. If no
special reference frame is in effect, Node locations are automatically defined relative to the complete
Global Frame.

NOTE: The Global Frame should be defined as soon possible to ensure that
all Node locations are correctly recorded.

This panel displays the current value of the Global Frame. This value is automatically computed from the
X, Y, Z coordinates of three locations that point at the following features of the reference frame:

e The origin (0,0,0) of the reference frame.

e Any position along the X-axis of the reference frame.

e Any position that is in the X-Y plane of the reference frame and generally along
the Y-axis.

NOTE: As soon as the X, Y or Z coordinate of any of the three locations is
altered, the Global Frame is immediately recomputed and the new value will be
reflected in the location of all Nodes that are relative to this reference frame.
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Global Frame Description

Launches the step-by-step wizard for teaching the three locations
that define the Global Frame. As a convenience, the "Line" and

Teach Frame "Free" buttons on the Air Dispenser can be used in place of the
\Wizard wizard's "Record" button and the Virtual Manual Control

Pendant. At the end of this operation, the new frame value is
automatically saved to the flash disk.

Ezgﬂ g(r)lg)];n Displays a pop-up that permits one of the three locations to be set
Teach POY equal to the current location of one of the syringe tips.
X, Y, Z, Yaw, Pitch, [Displays the three sets of location coordinates and permits them to
Roll be edited.

Displays a pop-up window that can move the robot to the
Move To : . " - .

associated location or to a position above this location.
Save Saves the frame value to the flash disk.

Purge Setup Sub-Panel

When the "Configuration" tab is clicked and the "Purge Setup" button is pressed, the panel pictured
below is displayed in the bottom right of the Configuration page. This panel defines where the robot is
moved to purge the two dispense heads and the duration of the purge operation.

Dunng a purge operabion, the robot will move to these two locations and enable the
dispense head(s). & ome value indicates the length of time the each dispense head will
operate. This operation is executed with the dispense headi(s) in the retracted position.

Teach Purge bt Y z Yaw Pitch Roll
Rec Head 1 || 636.2719 | 369378 | -3@6663 | 0 [ 180 | 180
Tinne 1 seconds Approach 10 Ll

Rec Head 2 || 6362719 | 369378 | -3mees3 | 0
Time 1 seconds Approach

Mave o]
_save |

The purge operation is a pre-defined process that safely moves the robot to a designated position and
dispenses fluids for a specified period of time. This function can be manually invoked from a number of
pages and is used to test if a syringe is operating properly and to clear the needle. The purge operation
performs the following steps:
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For this function, the speed and acceleration of the robot is defined by the Robot Motion parameters.

Retracts the robot to the Z height specified by the Safe Location.

Moves to the "Approach" position that is the specified number of mm above the
purge position.

Moves to the purge position with the syringe slide in the retracted position.
Turns on the syringe air supply for the specified number of seconds.

Retracts the robot to the Z height specified by the Safe Location.

Moves horizontally to the Safe Location.

For each syringe head, the following fields and buttons are defined.

Parameters

Purge Description

Run Purge

Executes the purge operation as defined above. This is the same
function that is available on a number of other panels.

Rec Head #

Records the current position of the robot (with no tool enabled) for
the selected dispenser head.

X, Y, Z, Yaw, Pitch, [Displays the purge location coordinates and permits them to be

Roll edited.

Displays a pop-up window that can move the robot to the purge
Move To " L . .

position or to a position above this location.
Time Specifies the duration that the syringe is purged in seconds.
Approach Defines the "Approach" height above the purge location.
Save Saves the purge settings to the flash disk.

Z-Search Sub-Panel

When the "Configuration" tab is clicked and the "Z-Search" button is pressed, the panel pictured below
is displayed in the bottom right of the Configuration page. This panel defines the parameters for
searching for the Z height of a surface using the "Z-Contact Sensor".
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Z Suarch Probu

The Z search probe allows for dynamic
adjustmertt of the syringe “Z' position pror to
runRing a path. This is done by searching
down using the synnge tip until contack with
the part. The parameters setup the values for
the search.

Probe digital signal L0039

Search speed (% max)
Search accal (9% max)
Search distance (mm)
Backout gap distance (mm})

The Z-Search is an option that can be selected for any Path. When enabled, at the start of the Path, GD
samples the Z-Contact Sensor to locate the height of the work surface at the first Node position. The
correction between the actual height and the Z height of the first Node is dynamically applied to all Nodes

in the Path.

If a Path has Z-Search enable, at the start of the Path, the syringe tip will be controlled as follows:

Moves to the "Approach" position above the first Node.

Moves down in Z at the "Search speed" and "Search accel" traveling a maximum
"Search distance".

Monitors the "Probe digital signal" and stops when the signal becomes TRUE.

Retracts the syringe at 25% of the "Search speed" until the "Probe digital signal

is FALSE. This permits a faster "Search speed" while still obtaining an accurate
height reading.

Computes the difference between the first Node's Z position and the detected Z
position minus the "Backout gap distance".

Moves to the first Node position and all subsequent Nodes in the Path applying
the Z correction and the X/Y/Z offset defined in the Path Editing Page to all

Nodes.

Normally, the Z offset specified in the Path Editing Page is utilized to move the entire Path up to the
proper height above the work surface to correctly dispense the fluid.

Z-Search
Settings

Description

Probe digital signal

Defines the Digital 1/0 signal number for the contact probe. This
signal becomes TRUE when the surface is detected. This defaults
to 10039, which is the DIN signal normally connected to the Z-
Contact Sensor.

max)

Search speed (%

Defines the speed (as a percentage of the robot's maximum

nominal speed) for the search motion.
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Search accel (%  |Defines the acceleration (as a percentage of the robot's maximum
max) nominal acceleration) to be used during the search motion.

Defines the maximum distance in mm that the robot is permitted to
move during the search. If this distance is exceeded, the search will

Search distance

(mm) fail and will generate an error.
Defines the distance in mm between where the slide is fully
Backout gap extended and where the slide is retracted sufficiently to trigger the
contact sensor.
Save Saves the settings to the flash disk.

Teach Buttons Sub-Panel

When the "Configuration" tab is clicked and the "Teach Buttons" button is pressed, the panel pictured
below is displayed in the bottom right of the Configuration page. This panel defines the system digital
input and output signals that return the state of the three buttons on the Precise Single/Dual Control Air
Dispenser and control their backlights. These settings should not have to be changed once a system is
wired and the hardware configuration has been debugged.

Teach Buttans

Below is a list of digital inputs and outputs
that are used for recording path points during
teaching.

Record Line Input 10034
Record Line Output (blink light) 34

Record Arc Input 10035

Record Arc Output (blink lighty [ 33
Togale Free Mode Input
Togale Free Mode Output

If you are using a Precise Air Dispenser mounted on a PrecisePlace robot, the DIO signals should be set
as shown in the picture above. These are signals that are provided by the robot's ZIO board that is
mounted next to the Z-axis motor. If you do not have a Precise Air Dispenser you can configure these
signals to connect to your own button box.

These buttons and lights are a programming convenience and are not needed for the proper operation of
the GD application program. If any of these signals are not present, their signal number should be set to
0 to avoid generating a runtime error.

Teach Buttons Description

Defines the DIO signals that are TRUE when the green create
Line Input/Output ['Line" Node button is pressed during teaching and that is set TRUE
to turn on this buttons backlight.
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Defines the DIO signals that are TRUE when the blue create "Arc"
Arc Input/Output  |Node button is pressed during teaching and that is set TRUE to turn
on this buttons backlight.

Defines the DIO signals that are TRUE when the red "Free" button
is pressed to place all of the axes into manual control "Free" mode
and that is set TRUE to turn on this buttons backlight.

Toggle Free Mode
Input/Output

Save Saves the DIO signal assignments to the flash disk.

Vision Sub-Panel

When the "Configuration" tab is clicked and the "Vision" button is pressed, the panel pictured below is
displayed in the bottom right of the Configuration page. This panel defines the interface parameters
necessary for using PreciseVision with GD.

Fraciss Visien Configuration

Specifiy the IP address of the PC that is running Pracise Vision.
The ‘Away Position” is the position the robot was during robot to camera calibration.

For ARM mounted camera, this point neads o be taught <o the camera is in focus for the
working surface of the robot. This point needs taught prior to using the ‘Calibration Setup’
wizard. The camera calibration is not valid if this point is changed after calibrating,

If this is a FIXED mounted camera, this point is used to move the robot out of the way of
the camera prior to taking a pichure.

l IP address of wision server.

192, 168.0,106 "-.-"lsiun test Process name Test Vision

(192.188.0.100)
| Select where the camera is mounted.

" Fix Mounted * Arm Mounted

Teach awveay robot position or camera calibration point.

*Warning* teaching this point will void the current arm mounted camera calibration.
Perform this operabicn once prior to calibrating vision.
Roba Yaw Pitch Rall

Robok -3 ¥ F
Teach Point || 5094748 | 263.967% | -38.9506 | [ 180 | 180 Move To |
Calibration Senap I
Save

Guidance Dispense contains built-in support for communicating with a PC that is executing

PreciseVision. When GD requires vision to compute a frame of reference, it sends PreciseVision a
command over Ethernet to execute a vision process. Typically, the vision process will consist of an
Acquisition tool (for taking a picture) and just a few tools for determining the position and orientation of the
object of interest. The results of the final tool are automatically returned to GD and dynamically replace
all of the components of the Global Frame with the exception of its Z height.
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In order for GD to communicate with PreciseVision, it requires the Ethernet IP address of the PC.

IP Address of Description
Vision Server

Specifies the IP address of the PC executing PreciseVision. This
address is used by GD to issue commands to PreciseVision and
retrieve data. This address can normally be found on the PC by
\viewing "My Network Places > Network Connections > Local Area
Connection > Status". By default, this is assumed to be
192.168.0.100. If you have executed the software installation
procedure for PreciseVision, this value will already be properly set.
Defines the name of a PreciseVision process that can be executed
to test that the communication connection is correct. Typically, you
should create a test process that just consists of an Acquisition tool
and a Fixed Frame tool positioned anywhere in the window. The
\value of this parameter is NOT SAVED to the flash disk.

\When clicked, sends a message to PreciseVision to execute the
"Vision Test Process". If the communication channel is operating,
the PreciseVision display will show that the process has been

Test Vision executed and GD will display the X & Y position of the vision result
(normally the position of the Fixed Frame). If the IP address is
incorrect, GD might hang for 1-2 minutes before the system times
out.

IP Address of vision
server

Vision Test Process
Name

The following radio buttons select how the camera is mounted. Fix mounting the camera above the robot
is advantageous if a large field of view is desired and you wish to take pictures when the robot is out of
the work area. An arm-mounted camera is preferred if you require higher resolution since a smaller field
of view can be used but you can still cover a large area by having the robot move the camera around the
workspace.

Select Camera Description
Mount

Indicates that the camera is mounted in a fix location above the
work surface of the robot. The camera does not move.

Indicates that the camera is mounted to the Z-axis of the robot. The
IArm Mounted camera must be moved back to the original picture position during
camera calibration.

Fix Mounted

In order for PreciseVision to return position coordinates and orientation angles that can be used by the
robot, the relationship been where the camera is looking (i.e. its field of view) and the coordinates of the
robot must be determined. This relationship is computed by performing a "Robot Vision Area
Calibration". The following parameters are used for this procedure.
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NOTE: For arm-mounted cameras, if the position defined in the following data
is altered after the calibration is completed, the calibration will be invalid and
must be computed again.

Camera Description
Calibration Point

Records the current robot position as the position that the robot will
be moved to when a picture is taken during the calibration process.
Defines the position that the robot will be moved to when a picture
is to be taken during the calibration process. For a fixed mounted
camera, this position should move the robot out of the way so it
does not block the camera field of view. For an arm-mounted
camera, this should position the camera over the calibration target

Teach Point

X, Y, Z, Yaw, Pitch,

Roll and at the proper Z height to produce the correct size for the field of
\view. This position should be defined before performing the
calibration procedure and only altered if you wish to re-execute this
procedure.

Move To Displays a pop-up window that can move the robot to the picture

taking position or to a position above this location.

Opens a small dialog that assists in performing the calibration
procedure. This window should be kept on the desktop while
Calibration Setup |performing the procedure. During an arm mounted camera
calibration, this dialog is used to move the camera back to the
picture taking position.

Save Saves the vision settings to the flash disk.

Virtual Pendant -- Main Web Page

The Virtual Manual Control Pendant (VMCP) page is displayed in its own browser window when the
"Virtual Pendant" tab in the Navigation bar is clicked. The VMCP provides the same functionality
available from a hardware Manual Control Pendant, i.e. the ability to manually move the robot in various
modes and display the current robot position.
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The "Positions" section at the top of the panel displays the location of the currently selected syringe tip

http:// 192,168,001 = Victual PendanEsiicios:

Fosition: PrecisePlace 1300c - KYZ

Jog Control
(Computer. [ World [ Tool [ Juint
Select Axis/Joint Jog Axis

[ [Rntemet T

and the position of each of the robot's axes.

Position Display

Description

Roll

X, Y, Z, Yaw, Pitch,

Displays the position and orientation of the currently selected
syringe tip in Cartesian coordinates. The X, Y and Z are in
millimeters. The three angles are in degrees and are a set of Euler
angles. These angles correspond to a Yaw rotation about world Z-
axis (rotating to the left and right along the horizon), followed by a
Pitch rotation about the new Y-axis (tilting to look up into the sky or
down into the ground), followed by a Roll rotation about the new Z-
axis (rotating to the left and right about the new vertical axis).

Jt 1/7 ... Jt 6/12

Displays the current position of each of the axes of the robot in

millimeters or degrees as appropriate.

The "Robot Status" section in the middle of the panel contains items for controlling motor power and robot

homing.

Robot Status

Description

System State

Please see the section on Enabling Motor Power and Homing the

Robot Homed

Robot for a description of these buttons and fields.

Enable
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The "Jog Control" section at the bottom of the panel is used to move the robot in various manual control

Disable

Home Robot

modes. Prior to jogging the robot, motor power must be enabled and the robot must be "homed".

To move, you first select a mode, then an axis or coordinate, then a speed and finally press the "+" or
key to move the axis in the positive or negative direction. Releasing the "+" or "-" key or changing modes

terminates the motion.

Description

(&
= |5
«
(@)
o
>
s
2
=)

Computer

Disables Jog Control and permits GD to take control of the robot
and automatically move its axes. This mode should always be
selected when you have finished moving the robot in jog mode.

.

orld

Moves all of the axes of the robot in a coordinated fashion such that
the selected syringe tip travels in a straight-line path along or
rotates about the X, Y, or Z axes of the robot’s world reference
frame.

]

Tl

Similar to World mode except that the reference frame is
determined by the selected syringe's orientation. For example,
since the Z-axis of the syringe normally points down, a positive
motion in tool Z will move the syringe down.

)

ot

Moves individual axes one at a time. Even if an axis is beyond its
limit stops, this mode can be used to drive the axis back into the
working range.

|
=
0
1)

/Allows one or more axes to be taken out of position control mode to
permit the axis to move freely. For lightweight robots, this allows
the operator to grip an axis and manually repositioned it.

<Select Axis/Joint>

Displays the axes that can be moved for the active jog control
mode. An axis must be clicked in order to select it to be moved.

Jog Speed %

Specifies the speed that the axis will move, specified as a
percentage of the maximum manual control speed. The speed can
be entered numerically, incrementally changed with the speed "+"
and "-" keys or by clicking one of the numbered speed keys. The
"Inc" keys move the axis by a small step and then stop rather than
moving continuously. This is convenient for making fine position
adjustments.

Jog Axis ("+", "-")

Moves the selected axis in the positive or negative direction at the
selected speed. For Free mode, multiple axes can be
simultaneously free'd by selecting the axis number and pressing the
"+" key. Pressing the "-" key or selecting a different jog mode un-
frees an axis.

66

Copyright © 2022, Brooks Automation, Inc.




Brooks Automation

Software Introduction
P/N: GDP0O-DI-S0010, Rev 5.0.0, April 9, 2022

Help -- Main Web Page

The Help Panel is displayed when the "Help" tab in the Navigation bar is clicked. This page provides

links to abbreviated online versions of much of the help information that is available in this chapter plus
the tutorial examples.

:i Custom Fiome - Miorosofl Intemet E;-:F]Id_'lrl:'l' 108 A0 el SR,
Efle Bt Meew  Farorites Tools o Help il
Ackress [F himpcvise. 1680, /Mah/sppweb bl o s =
FPRECISE E
_.fo oA 0N Guidance Dispanse
Comeratar T Ede s DCanhigarabon: [REnal Perdsnt) THelp
Guidanre Dispense Yersian 10001
Eulld 070012
Help Toplc
{elick to mpen) Descripton
Gudarde Dspanse Dverview of Soltwase and Web Page lapout.
Giedardsd Cuipense Operator confrol panel. This panel aliows 3 ganeral user
b soloct pro-definnd procossos o man. This panel is alsp usod ta intaize
thea robiot dunng powesr up and Mlows sdusting system wids spepd,
Frovadas settings for setup and debig of & dspenge paths.
udarce Controller standard sirual pendant, (Plesse fée gudance
cantrollar garumentation)
Degcnbas the differant types of path nodes ard what rulos must be followed
whon buld a path.
Tafblo conkains comman rrar messages and pop-up mossages that you may
encourter duning the normal operation of the Gudance Gispense system.
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Centaing & series of Stea-By-Step Tuterisls for the Gudance Cepende
% SCfTware SOENCETON, THESE DLOnals are intened T Mirofuts all of the
epnlication Tutonals |25 PErations requined to satup the system and devalop smplfied typical
applications.
SQuare TwRongd
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Step-By-Step Tutorials

Tutorials Introduction

This chapter contains a series of Step-By-Step Tutorials for the Guidance Dispense software
application. These tutorials are intended to introduce all of the basic operations required to setup the
system and develop simplified typical applications.

These tutorials are organized into two groups:

e Setup Tutorials. These introduce all of the steps necessary to operate the
system and initialize parameters that define the dispensing tools and
workspace. These tutorials should always be executed in the order they are
presented since they initialize data that is inter-dependent. In general, these
tutorials only have to be executed once until the tooling or some element of the
work cell is modified.

e Application Tutorials. The first tutorial is a complete, basic example. This is
followed by a series of modifications of the basic example. These variations can
be executed in any order.

Before performing these tutorials, please ensure that the following has already been completed.

e A PC has been interfaced to the robot and a suitable web browser can display
the graphical user interface of the robot controller. If this has not been
completed, see the Setup and Installation chapter of this manual.

e The Guidance Dispense software has been installed on the controller and has
been started. This information can also be found in Setup and Installation.

e You have reviewed the Hardware and Software Introduction chapters of this
manual. A thorough understanding of the content of these sections is not
required since much of what you read will become clearer as you perform the
tutorials. However, a understanding of the basic operation of the hardware and
the concepts and nomenclature of the software will be very helpful.

DANGER: Before operating your robot, ensure that the following
steps have been performed: (1) the robot has been properly
mounted; (2) all required safety interlocks have been installed and
tested; and (3) power has been connected. For the PrecisePlace
robots, this information is provided in the “PrecisePlace 2300/2400
Robot, Hardware Introduction and Reference Manual”.
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It's now time to get started with the tutorials! Please begin with the Setup Tutorials and execute them in
order.

Setup Tutorial 1. Enabling Power and Homing

The first step in operating the system is to "enable power" and "home" the robot. Enabling power
provides power to the motors. Homing establishes the absolute 0 position of each axis so that previously
taught motions can be exactly repeated. Many robots lose track of their axes 0 positions when power to
the controller is turned off. Homing reestablishes the 0 references using whatever technique is
appropriate for the axes, e.g. pressing into a hard stop, engaging a limit switch, reading special encoder
tracks, etc.

As a convenience, power enable/disable and homing buttons are provided on a number of different web
panels (e.g. the Operator Control Panel, the Virtual Manual Control Pendant (VMCP), the Robot Status
section of Edit and Configuration Pages). All of these buttons perform the same functions. For this
example, we will use the Operator Control Panel.

» Open the Operator Control Panel by clicking Operator >.

System Messages

GPL: "Application Intialized"” ﬂ
"*File not found™ "
: "*Filg not found® Mashipathprefivision.pph”
. “*File not found* fflash/pathpref/teachbox.ppb”
‘*Ejla not found* fMfash/pathpref/probsinfo.pph’

r‘jPL:. " Flbenot found® .n’r'las‘r'l.fnamnrefnluans it

Robot Status Llear Messages

If you have started a newly loaded system that has not had all of the configuration data defined, there will
be a number of benign error messages displayed in the "System Messages" window.

» Press Clear Messages to eliminate the clutter of the old messages. (This step is not
required to enable power.) Then press Enable to turn on power to the motors.
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The "System state" will transition from "Off: switch on wait" to "GPL Ready" to indicate that motor power
has been successfully enabled.

» Press Home Robot to establish the zero position for each of the axes. This
operation will move the robot and may take a minute or two to complete.

When the homing successfully completes, the "Robot homed" field will change to "Yes". Once
completed, homing does not have to repeated until the robot controller is powered down, no matter how
many times motor power is enabled and disabled.

Setup Tutorial 2: Manually Moving the Robot

In many of the following tutorials, you will be required to manually position the robot. GD provides several
ways of accomplish this (e.g. the Red "Free" button on the Air Dispenser, the Virtual Manual Control
Pendant (VMCP), the optional hardware Manual Control Pendant, and the Robot Status and Mini Jog
panel on the Edit and Configuration Pages). All of these methods. provide an equivalent or subset of the
capabilities of the VMCP that will be discussed in this section.

» Open the Virtual Manual Control Pendant by clicking Virtual Pendant >.

Position: PrecisePlace 1300c - XYZ

[

0 | D000 | 0000 | 0000 | 1B0.000 [ 180.000
| |

I_nmn_| D000 | 0000 |
| |

Robot Status

Jog Control

Compiuter Wrerdil Ticael lentil

Select AxisIoint

crommmll - |
control +

Ergaged

- Ink Thr e
= Manssl 1 10 100

i |20 40 (G0 B0 90 100 +
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The VMCP will appear in its own browser window. The upper section of the VMCP provides a dynamic
display of the robot's current location. The lower area contains the "Jog Control" section whose modes
are summarized in the following table. Prior to jogging the robot, motor power must be enabled and the
robot must be "homed".

Description

_ Disables Jog Control and permits GD to take control of the robot
Computer and automatically move its axes. This mode should always be
selected when you have finished moving the robot in jog mode.
Moves all of the axes of the robot in a coordinated fashion such that
orld the selected syringe tip travels in a straight-line path along or
rotates about the X, Y, or Z axes of the robot's world reference
frame.

Similar to World mode except that the reference frame is
determined by the selected syringe's orientation. For example,
since the Z-axis of the syringe normally points down, a positive
motion in tool Z will move the syringe down.

Moves individual axes one at a time. Even if an axis is beyond its
it limit stops, this mode can be used to drive the axis back into the
working range.

IAllows one or more axes to be taken out of position control mode to
EE permit the axis to move freely. For lightweight robots, this allows
the operator to grip an axis and manually repositioned it.

B B B N B (s
_‘I — = - o
- ) B

3

To move a single axis in manual mode, do the following:

» Press Jog Control > Joint.

» Select a joint to move, e.g. Joint 1

» Select a slow speed initially, e.g. “10”

» Move the axis in the positive or negative direction by holding down the “+” or “-“ keys.
The World and Tool modes operate in the same fashion. The Free mode is a bit different in that multiple
joints can be freed at once and the speed setting is not used. For this mode, each time you select an axis
and press the “+” the axis is freed until you press the “-“ key to place the axis back into position control
mode.
In Joint, World and Tool modes, if any of the "INC" speeds are selected, the robot will move a discrete
increment and then stop instead of moving continuously. If you release the "+" or "-" key and press it

again, the robot will move another increment. This is very convenient for fine positioning the robot.

Try to move the robot in each of the manual modes and at various speeds to get a feel for the virtual
pendant.
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» When you are done practicing manual control, press Jog Control > Computer. This
disables Jog Control and permits GD to automatically move the robot when required.

For additional experience, you should try to move the robot using the alternate interfaces, i.e. the optional
hardware Manual Control Pendant, and the Robot Status and Mini Jog panels on the Edit and

Configuration Pages.

Setup Tutorial 3: Teaching the Safe Location

When a Process begins execution and after it is completed, the robot is automatically moved to a fixed
Safe Location. This safeguard helps to avoid inadvertent crashes with obstacles in the workspace. In
addition, some standard operations, such as Purging syringes also move to this location for the same
reason.

The Safe Location should be set to a position that is always clear of obstacles and that generally
positions the robot out of the way.

NOTE: The Z height of the Safe Location is particularly important since the robot
moves to the Safe Location by first retracting to this Z height and then moving
horizontally to the Safe Location. So, the Z height should be above the highest
obstacles in the workspace.

» To define the Safe Location, open Configurations > Robot Motion.
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Fahat Motion

| Safe Location |

The safe pointis where the robot will move o
befare and after performaing a dispenze
PrOCEss.

Teach Safe Pont I Move Safe Point |
| General Motion Settings ]

Settings that are used during moving
between paths and back to the safe location.

Run Speed (% max) [ 30
Edit Speed (% max) [ 10
ApcelfDecal (% max) W
Accal Ramp (seconds) [ o1

[ Path Verify Test 1
Each path point should be taught above the
global frame of reference (including any
offset). This value is the value used to check
against, Set to large negative to disable,

Z path node test 0 M

Save

» Manually position the robot at the location that you have selected for the Safe
Location taking special care in selecting the proper Z height.

» Press the Teach Safe Point button.
» When asked to "Record Safe Position", press Yes.
» If you are asked "File Exists: Okay to Delete", press Yes.

You have now successfully taught the Safe Location. This position will automatically be used whenever
the system needs to move the robot to a height or position that is clear of obstacles and out of the way.

If you wish to verify the Safe Location, you can manually move the robot to another position and then
press the "Move Safe Point" button.

Setup Tutorial 4. Teaching the Dispense Heads

While it is permissible to teach a Path and repeat the Path without knowing the dimensions or mounting
position of the syringe heads, this is not the recommended procedure. If GD is taught this information, if
a syringe and needle size changes or if a syringe needle bends, GD can automatically adjust the robot
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motions so that the new syringe tip will follow the previously taught Path. In addition, if two syringes are
used, the Nodes taught with one syringe can be easily repeated by the other syringe.

» To define the Dispense Heads, open Configurations > Dispense Heads.

Dispenss Haads
Up to 2 dispenser heads can be mounted on the end of the arm. Each one can have a
unigue tool offset that is applied duning teaching and playback.
Initial Setup Steps:
1. Teach initial reference point using dispense 'Head 1' and cick 'Rec Reference’.
2. Move robot so Head 2 is at the reference point and click "Rac Offset 2.

After Changing Tip: gﬂzzt‘diﬁnenser head to initial reference point and click 'Rec

Referance Vaw Pirch Rl
Rec Beference I (1] 1] (1] Move To

Head 1 z Yaw Pitch ol

Rec Offzet 1 [ o I o [ o | 0 Move Ta
Extend Signali 36 Dispense Signal a7

Euhrull Fatract (al}] OFF I
¥ 3

Yaw Plech Roll

Rec Offeer 2 || [ 0 | 0 | 0 | 0 [ 0 Move To
Extend Signal 0 Dispense Signal ag

m Euuhdl Rétract oN OFF |

 Head2

Save

To simplify training the dimensions and mounting of syringes, you must select a "Reference Point" in the
work cell that does not move. Then, to teach the dimensions and mounting of a different syringe tip, you
only need to position that tip at the same Reference Point and click a button. GD will compute the
required information and will automatically put this data into effect each time the syringe is selected.

NOTE: Once the Reference Point value is taught, it should not be changed. If
this value is re-taught with a syringe tip that is a different size or is mounted in a
different position on the robot, it will alter the result of any syringe tips that are
taught with respect to this new Reference Point and any formerly taught Path's
will be incorrect.

» Manually move syringe tip #1 to the position you have selected as the "Reference
Point".
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» Press Record Ref and Yes to confirm.

» To compute the initial offset for head #1, without moving the robot, press Rec Offset 1
and Yes to confirm.

» If you have a second syringe head, manually position it at the Reference Point.
» To compute the initial offset for head #2, press Rec Offset 2 and Yes to confirm.
» Press Save to store the results on the flash disk.

You have now successfully taught the dimensions and mounting information for the dispensing
heads. Whenever you select to use a head, this information will automatically be put into effect by GD.

If at anytime you either change one of the syringes, adjust the mounting of a syringe clamp or bend a
syringe tip, perform the following procedure to re-train the new dimensions and mounting information.

» Manually move the syringe tip to the position you have selected as the "Reference
Point".

» To compute the new offset, press Rec Offset for the desired head and press Yes to
confirm.

» Press Save to store the results on the flash disk.

Setup Tutorial 5: (Optional) Teaching the Purge Locations

If you wish to execute the manual Purging sequence later to either test the operation of the syringes or to
clear the needles, the locations where the robot is to purge the syringes must be taught. The purging
operation can be manually initiated from the Operator Control Panel, the left panel of the Edit or
Configuration pages or from the Purge Setup panel. If you do not wish to execute purging, this exercise
can be skipped.

» To define the Purge Locations, open Configurations > Purge Setup.
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Durng a purge operabion, the robot will move to these two locations and enable the
dispensa head(s). A ome value indicates the length of time the each dispense haad will
operate. This aperation is executed with the dispense head(s) in the retracted position.

Teach Purge bt Y z Yaw Pitch
Rec Head 1 || 6362719 | 369378 | -3;6663 | [ [ 10 |

Tirme 1 seconds Approach 10 i

Rec Head 2 || 636.2719 | 369278 | -9m6ee3 | 0 [ 1em |
Time 1 seconds Approach 10 i

Mave Tol
_save |

» Manually position the robot at the location that you have selected to purge the first
syringe.

» Press Rec Head 1.
» If you are asked to "Overwrite current position”, press Yes.

» Fill in the purging Time and the height that the robot should Approach the purge
location.

» Repeat for the second syringe head if it is being used.
» Press Save to store the results on the flash disk.
You have successfully taught the syringe Purge Locations. They will automatically be used whenever the

Purge operation is invoked. If you wish to verify the locations, you can manually move the robot to
another position and then press "Move To". If you wish to test purging, press "Run Purge".

Setup Tutorial 6: (Optional) Vision Interfacing and
Calibration

If your system includes PreciseVision, the following procedure must be performed to interface GD to
Vision and to compute the calibration data that translates vision results into coordinates useable by GD.

» To access the PreciseVision setup panel, open Configurations > Vision.
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Frecies Vision Configuration
Specifiy the IP address of the PC that is running Pracise Wision.

The ‘Away Position” is the position the robot was during robot to camera calibration,

For ARM mounted camera, this point needs to be taught =0 the camera is in focus for the
working surface of the robot. This point neseds taught prior to using the "Calibration Setup’
wizard. The camera calibration is not valid if this point is changed after calibrating,

If this is a FIXED mounted camera, this point is used to move the robot out of the way of
the camera prior to taking a picture.

l IP address of vision server.

19T 168,0,106 "-.-"|5i|;|n test Process name Test Wision

(192.168.0.100)
| Select where the camera is mounted.

© Fix Mounted * Arm Mounted

Teach away robot position or camera calibration point.

*Warning® teaching this point will void the current arm mountad camera calibration.
Perform this operabion once prior to calibrating vision,
Robot o L 2 Yaw Pitch Ball

| Robot
Teach Point || 5094748 | 2639679 | -38.9506 | [ 180 [ 180 Move To |
Calibration Setup I
Save

This procedure assumes that you have already installed PreciseVision on a PC, connected the camera,
and established the Ethernet link between PreciseVision and your robot controller. If not, please refer to
the "Supported Hardware and Software Installation” chapter of the Precise Vision Machine Vision System
Introduction and Reference Manual before continuing this tutorial.

» To verify that the communications link is properly working, within PreciseVision, create
a Vision Process named "Gd_test" that only contains a camera Acquisition tool.
» In the "Vision test Process name field", enter "Gd_test" (without quotation marks)
» Press Test Vision.
If the communication link is operating properly, you will see a new picture in PreciseVision's camera

window. If this does not occur, re-execute the Software Installation processes in the PreciseVision
manual.

If your camera is fixed mounted (i.e. not attached to the robot), perform the following:

» Check the Fixed Mounted radio button.
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» Manually move the robot to the position that you would like it to move to when GD
automatically takes a picture during a dispensing Process. This should be selected so
that the robot and its shadow do not interfere with the picture.

» To record this position, press Teach Point and press Save to store the results on the
flash disk.

» Execute the Robot Vision Area Camera Calibration procedure described in the
PreciseVision manual.

If your camera is arm-mounted (i.e. it is attached to the robot), perform the following:

» Check the Arm Mounted radio button.

» Manually move the robot so the camera is over the area where you wish to perform
the calibration process. It is very important that the Z height be correct so that the
camera’'s field of view is properly focused. This Z height will be used when GD
automatically takes a picture during a dispensing Process.

» To record this position, press Teach Point and press Save to store the results on the
flash disk.

» To obtain step-by-step information on performing an arm-mounted camera calibration,
press Calibration Setup and follow its instructions.

NOTE: For arm-mounted cameras, if the taught robot position is altered after
the calibration is completed, the calibration will be invalid and must be re-
computed.

This completes the PreciseVision setup and camera calibration procedure.

Application Tutorial 1: Basic Application Example

After having completed the Setup Tutorials, we are now ready to develop our first dispensing
application. In general, the Setup Tutorials will not have to be re-executed unless the tooling or some
element of the work cell is modified.

In the last section of this chapter, the Sample Applications Templates contain four example dispensing
patterns.
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» Print the "Template #1: Sample Square Path" and secure it to the robot's work
surface. This template contains the square dispensing pattern that we will train in this
tutorial.

STEP 1: TEACH THE GLOBAL FRAME

All Node locations are defined relative to a reference frame. In the absence of a special frame, Node
locations are defined relative to the Global Frame. The value of this frame can be left unchanged, but it
is good form to always start an application by setting this frame to a meaningful value. For this tutorial,
we will align the Global Frame with the X & Y axes drawn on the template.

» Open the Global Frame definition panel Configuration > Global Frame.

dilabal Frams
The global frame is what path points are taught
relative to, Click the Teach Frame Wizard” button
below to walk through teaching the frama.

‘When teaching the frame paints, it is impaortant
to follow the nght hand rule, These ponts
describe 3 plane where the Cartesian "2” axis is
pointing up.

Teath Frame Wizard

.4 ¥
Tesch Orgin | [ 3707414 | 2200307 [ - 180 Mows Tbj
Tesch 0Ok |[ 3728528 [ soss0a [ - [ 180 Mowve To
Tusch POV || 30,2799 | 2302m12 [ - LE0 180 Mawa T

M ¥ o Bitch Eall
Frame Value: [271.7414 |[zzn20rs [ - (R | TEFITH |

Savi

Within GD, frames are defined by specifying three points: the origin of the frame, a point on the X-axis
and a point roughly on the Y-axis.

» Execute the frame teaching aid by pressing Teach Frame Wizard and confirm that
you wish to continue by clicking Yes.

» When asked, select the head that you will use during this Wizard by clicking Head _x.
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» When asked to record the Origin, Point On X and Point On Y, manually position the
selected syringe tip at the points on the template marked "Origin", "POX" and "POY"
and click the Record button at each position. (As a convenience, the "Line" button on
the Air Dispenser can be used in place of Record and its "Free" button can be used to
manually position the robot.)

» Press the Save button to store the results on the flash disk. Respond Yes when
asked if it is okay to delete the existing file.

This completes the training of the reference frame.

STEP 2: CREATE A NEW "PATH" AND TEACH ITS "NODES"

A Path contains a sequence of positions ("Nodes") that defines the motion of the syringe tip and
specifies when dispensing is turned on and off. A single Path can only define the actions for a single
syringe head. Normally, Paths are kept relatively short since multiple Paths can be combined into the
final dispensing "Process" that is executed.

Given the simplicity of this example, we only need to create a single Path to define the desired
dispensing operation.

» Open the Path Editor panel, Edit > Path Editor .
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The top of the panel is for managing and defining Paths. The middle right section is utilized when a Path
is defined relative to the results from PreciseVision. The bottom is for managing and defining Nodes
(positions) in the currently selected Path.

We will use a wizard to create the new Path and to create and record the positions of its Nodes.

» To create the Path, under "Path Files", click New.

» A pop-up will be displayed that asks "Create new path file or Teach new path

file?". Pressing "CreateNew" will create a new Path but will not define any Nodes. To
create the Path and to create and teach the Node positions, press TeachNew.

» When requested, enter the name of the new Path as "Square" (with no quotes).

» When prompted, specify the dispense head you will use for training and to dispense

by clicking either Head 1 or Head 2.

The pop-up panel from the teach wizard will now ask you to teach the position for the first Node in the
new Path.
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P1: Posmon poonter And click [Racord]

From this wizard, you can teach the positions of Line, Arc, and Break Path Nodes. Other Node Types
can be inserted later. Also, the Types of the taught Nodes can be subsequently modified.

» Using any of the manual control methods, position the syringe tip at P1 on the
template. Itis normally easiest to have the syringe tip lightly touch the template. The Z
heights of the positions can be adjusted individually or as a group later.

» Create the first Node as a Line Type and record its position by either clicking the
RecLine button in the pop-up or pressing the green Line Button on the Air Dispenser.

» Repeat the process for the other positions, P2, P3, P4, P5 and P6

» Terminate position teaching by pressing Quit.

The editor panel should now resemble the following:
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Note that although you taught 6 Line Nodes, when displayed, the first Node is a series of straight-line
motions is labeled "LineStrt" and the final Node is labeled "LineEnd". This is automatically done by GD
to make the list of points more understandable.

STEP 3: EDIT NODE AND PATH PROPERTIES

If you click on a line in "Path Points", the Node's position relative to the Global Frame is displayed at the
bottom right together with other information about the Node. Currently each Node is a Line Type and
has dispensing turned off.

Using the buttons next to the Node display, you can edit the Path by adding or deleting Nodes, recording
new position values, etc. The "Set Value" button permits a coordinate value to be changed in a group of
Nodes. The "Advanced" button permits a group of Nodes to be copied or deleted or for new Nodes to be
inserted using the teaching method.

Before we execute this Path, we wish to edit a few properties.

» To turn on dispensing at the first Node, in "Path Points", click on "1. LineStrt" and in
"Selected Path Point" data, pull-down the list of options below "Dispense" and select
Turn On.
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» To turn off dispensing at the final Node, in "Path Points", click on "6. LineEnd" and in
"Selected Path Point" data, pull-down the list of options below "Dispense" and select
Turn Off.

To the right of the "Dispense" pull-down list, you will see the "Mode" and "Value" fields. These fields
have different interpretations for the different Node Types. For the Line and Arc Nodes, these values
control when dispensing is turned on or off relative to the start or end of the motion. In this example,
since the motions for P1 and P6 overlap slightly, these field can be used to delay turning on dispensing or
to turn it off early.

We now wish to modify the parameters that apply to the Path overall.
» In the Path "Global" data, change the "Dispense Spd" and the "Trans Spd" to "5"
mm/sec. This reduces the nominal speeds when fluid is and is not dispensed.

» Set the "Approach" and "Depart" heights to "50" mm. This increases that height that
the robot will move above the first and last Nodes when starting and ending the Path.

» Set the "Z" value of the "Offset" to "10". This will lift all of the Node positions by 10
mm. Once the Path has been verified, this value can be reduced to obtain the correct
distance between the syringe tip and the surface to properly dispense the fluid.

» Click the Save Path button to save the changes and respond Yes to the confirmation.

STEP 4: CREATE THE PROCESS

To assist in debugging, it is possible to execute a single Path directly from the Path Editing panel. But,
since our entire Process will consist of one Path, we will directly move to creating and executing the full
application.

» Open the Process Editor panel, Edit > Path Editor .
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» To create the Process, click New.

» When requested, enter the new process name as "Square_Proc" (without quotation
marks) and click OK to confirm.

» In "Process Files", click on Square_Proc. In "Available Paths", click on Square.
» To add the Square Path to the Square_Proc Process, press Append.
» Click the Save button to save the changes to the flash disk, and click OK to confirm.

This completes the creation of the Process. If we had more Paths to add, they would appear in the
"Available Paths" list and could be appended as well.

STEP 5: EXECUTE THE PROCESS

We are now ready to execute this Process.

» Open the Operator Control panel, Operator > .
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In order to execute the Process, motor power must be enabled and the robot must already be homed as
indicated in the "Robot Status”. In the Select Process area, the overall speed of the robot can be reduce
for testing.

» Reduce the speed of all robot motions by clicking the 10 % speed button.
» To inhibit dispensing fluid during testing, check the Disable Outputs box.
» Select the application to run by clicking on Square_Proc and press the Start to begin

execution.

Congratulations! You have just developed and executed your first dispensing application with Guidance
Dispense.

At this time, we suggest that you try running the application at various speeds and adjusting the Z height
of the Path offset with the dispense outputs enabled until you achieve a good, consistent dispensed fluid
pattern.

For additional practice, you should print out the remaining three examples in the Sample Applications
Templates and program these test patterns as well. Each sheet has the list of Nodes that should be
trained to produce the test pattern.
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Application Tutorial 2: Adjusting for Base Shifts and
Rotations

This tutorial demonstrates that if the base of a dispensing Path has been shifted and/or rotated, the
Global Frame can be adjusted to compensate all of the Path's Node positions.

This training example requires that Application Tutorial 1 has already been completed and builds upon its
results.

» For any of the sample templates, execute the Process again to verify that the
dispensing path is accurately being followed.
» Shift and rotate the sample template on the work surface and secure it again.

» Open the Global Frame definition panel, Configuration > Global Frame.
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We now need to re-teach the Global Frame and realigning it with the X & Y axes drawn on the
template. Since all of the Node locations have been defined with respect to this reference frame, once
the Global Frame is updated, all of the Node locations will be automatically compensated.
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» Execute the frame teaching aid by pressing Teach Frame Wizard and confirm that
you wish to continue by clicking Yes.

» When asked, select the head that you will use during this Wizard by clicking Head_x.

» When asked to record the Origin, Point On X and Point On Y, manually position the
selected syringe tip at the points on the template marked "Origin”, "POX" and "POY"
and click the Record button at each position.

» Press the Save button to store the results on the flash disk. Respond Yes when
asked if it is okay to delete the existing file.

» Execute the Process again and verify that the dispensing path is once again
following the pattern on the shifted and rotated template.

Application Tutorial 3: Automatic Z Height Adjustment

If your system is equipped with a Z-Contact sensor or similar device that can detect the Z height of a
surface, this tutorial illustrates how this sensor can be used to adjust the Z heights of all of the Nodes in a
Path. When enabled, GD will perform a Z-Search as follows:

e Moves to the "Approach" position above the first Node of a Path.

e Moves down in Z until the sensor is tripped.

e Computes the difference between the first Node's Z position and the detected Z
height.

e Moves to the first Node position and all subsequent Nodes in the Path applying
the Z correction and the X/Y/Z offset defined for the Path.

When a Z-Search is performed, the Path Z Offset value is utilized to adjust the height of the Path after
the correction is applied. For example, if the Z Offset is set to 0, after the surface is detected, the Z
height of the first Node would be set to the height of the surface and all subsequent Nodes would be
corrected accordingly. Typically, the Z Offset is set to be equal to the gap desired between the surface
and the syringe tip.

This training example requires that Application Tutorial 1 has already been completed and builds upon its
results.

» For any of the sample templates, execute the Process again to verify that the
dispensing path is accurately being followed.

» Open the Path Editing panel: Edit > Path Editor .
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Application Tutorial 4: Repeating a Path in a Grid Pattern

Once a Path has been created, it is very easy to have the Path repeated in a 1, 2 or 3 dimensional grid
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» Select the Path for the template that you are using for this tutorial.
» Enable the Z-Search for this path by setting the Search pull-down to Use Probe.

» For testing purposes, increase the height of the Path so it is well off the surface by
setting the Z Offset value to "10" mm.

» Press the Save button to store the results on the flash disk. Respond Yes when
asked if it is okay to delete the existing file.

» Execute the Process again and confirm that the syringe tip contacts the surface and
then backs off 10 mm.

» In the Path Editor, reduce the value of the Z Offset and re-execute the Process until
the Path height is correct and the fluid is being correctly dispensed.

» To verify that the Z-Search is operating correctly, manually adjust the height of the
template and execute the Process again.

pattern. This is useful for dispensing fluid on parts that are stored in a pallet or for repeatedly stepping a
fixed distance and duplicating a dispensing pattern.

This training example requires that Application Tutorial 1 has already been completed and builds upon its

results.

» For any of the sample templates, execute the Process again to verify that the
dispensing path is accurately being followed.
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» Open the Path Editing panel: Edit > Path Editor .
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A Path is always indexed along the major axes of its reference frame. For example, if a Path is relative
to the Global Frame, you can step in the positive or negative direction of its X, Y or Z axes. You cannot
step diagonally. However, since you are free to select the orientation of the reference frame for a Path,

this does not impose a significant limitation.

By default, the number of "Pallet" indices (ldx) is 1, which means do it once and don't step.

» Select the Path for the template that you are using for this tutorial.

» Change the number of Pallet indices (Idx) in X to "2". This will repeat the pattern
once by stepping once in the X direction.

» To specify an index step size of 25.4mm, change the X Pitch to "25.4".

» Press the Save button to store the results on the flash disk. Respond Yes when
asked if it is okay to delete the existing file.

» Execute the Process to view the results.

Since we are only indexing in one dimension, the order in which we index the X, Y and Z values is
immaterial. However, if we did specify more than one indexing direction, the "Order" pull-down could be
change to re-order which axis we indexed along first.

This completes the modifications for repeating a Path.
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Application Tutorial 5: Using Machine Vision

If your system is equipped with PreciseVision, the application of machine vision in GD is very
straightforward. PreciseVision dynamically computes the reference frame for a Path and this reference
frame is used in place of all of the components of the Global Frame except for its Z height. If
PreciseVision cannot locate the reference frame or if it performs an inspection operation that indicates
that a part is not acceptable, it will return an error that will stop execution of the GD Process.

After the Vision Interfacing and Calibration tutorial is performed, all communication with PreciseVision and
the translation of all results into coordinates that can be applied to Paths is automatically handled by GD.

The procedure for developing a vision based dispensing application can be summarized as follows:

e As with the Basic Application Tutorial, start by teaching a Global Frame. This
reference frame should be selected keeping in mind that vision will need to
generate the same frame.

e Follow the same procedures as before and create and define dispensing Nodes,
Paths and a Process.

e After your Process has been debugged, create a Vision Process in
PreciseVision that can dynamically locate and return the same reference frame
as the Global Frame.

e Flag any desired Path's to indicate that they are relative to the vision reference
frame instead of the Global Frame.

e Execute your new vision-based dispensing application.

The new steps in this procedure will be described in this tutorial. Prior to reading this material, you should
familiarize yourself with the basics of applying PreciseVision.

This training example requires that Application Tutorial 1 has already been completed and builds upon its
results.

» For any of the sample templates, execute the Process again to verify that the
dispensing path is accurately being followed.

In this tutorial, pictures of the Square template will be presented for illustrative purposes, but any of the
other templates can be used as well. To mimic the manual training of the Global Frame, we will be
training vision to locate the positions of the lines drawn on the template for the X and Y axes. In areal
application, coordinate axes are rarely present. Instead, features such as distinct edges with an included
corner or fudicial marks can be selected for both the manual Global Frame definition and the automated
vision identification.

We start by illustrating how PreciseVision is trained to locate the X and Y axis lines.
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» Position the dispensing template below the camera. It is not necessary to accurately
position the template in the camera's field of view. All that is required is that a portion of
the X & Y axes are visible.

» If the camera is mounted on the robot, ensure that its Z height is the same as the
calibration point in the GD Vision panel. You can use Move To on the Vision panel to
correctly set the Z height.

» Using PreciseVision, take a picture by selecting File > Acquire New Image.
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» In PreciseVision, create a new Vision Process named "Xy_axes_frame".

» Create and add to this Vision Process an Acquisition Tool followed by a Line-Line
Frame Tool.

» Create two Line Fitter Tools and provides these as the inputs to the Line-Line Frame
Tool.

» Position the first Line Fitter to locate the X-axis and the second Line Fitter to locate
the Y-axis of the template.
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This Vision Process will take a picture and determine the two lines that best fit the X and Y axes of the
template. Then, a reference frame is computed whose origin is the intersection of the two line fitters and

who's X-axis is aligned with the results of the first Line Fitter.

This completes the vision training. The Xy _axes_frame Vision Process can now be executed by

Guidance Dispense whenever the template reference frame needs to be located.

Returning to Guidance Dispense, we must now mark the dispense Path as being relative to the vision

results in place of all of the components of the Global Frame except for its Z height.

M

M

M

» Open the Path Editor by clicking Edit > Path Editor.
» Select the Path for the template that you are using for this tutorial.

Flag this Path as being relative to a vision result by checking Use Vision.

» Specify the Vision Process to be executed to locate the reference frame by entering

"Xy_axes_frame" (without quotation marks) into the Process Name field.

Copyright © 2022, Brooks Automation, Inc.

93



Step-By-Step Tutorials

Guidance Dispense System
P/N: GDPO-DI-S0010, Rev 5.0.0, April 9, 2022

™ Disable Outputs

Path Points
1. Linescrc-on WS iser

LineNid

. LineMid

+ LineMid
LineEnd -0FF

. LineMid Append

M usevigion [T tndes Camera

My _anes_frame

Wighon Tool Hame {apt)

Picrura Location

Yaw Pitch

Yaw Ritch Roll

| ssnse | 2204 [-2i24 | 0o | 1eo | 180

Crispense Made Walie

=] [rumon =] [mmEd =] | o

» The Vision Tool Name can be left blank since we just want the results from the last
vision tool that is executed, the Line-Line Frame tool.

» If the camera is mounted on the robot and you want to move the camera to a position
other than the point where the camera was calibrated, manually move the camera to the
correct position and Z height and press Record.

» Press Save to store the results on the flash disk.

This completes the extra steps necessary to develop a vision based dispensing application! Your
previously created Process can be executed as before. As a test, try displacing and slightly rotating the
template to verify that the Path is being dynamically updated.

Sample Application Templates

The following are a series of sample Paths. These should be printed out and used in connection with the

Tutorials presented earlier in this Chapter.
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Reference Information

Dual Control Air Dispenser Pneumatic Connections

The Dual Control Air Dispenser controls the air lines for the two syringes and the pneumatic actuator for
the vertical slide for the first syringe clamp. For each syringe, this device provides two pressure
regulators: one to control the positive pressure utilized to dispense the fluid from the syringe and a
second regulator that supplies air to a venturi device that creates a vacuum in the syringe air line when
the positive pressure is turned off. The vacuum assists in withdrawing the syringe plunger to minimizing
dribbling of the dispensed fluid.

The picture below illustrates the pneumatic inter-connections between the components of the Dual
Control Air Dispenser.

Syringe #1 Syringe #2
Air Reg VAC Reg VAC Reg AirReg

Ty
"
.

7 -

o~

_ Air Intake
Syringe - -
Clamp Slide %
Valve
Syringe #1 / ' Syringe #2
Valve WValve

Syringe #1  Syringe #2
Veanturi Venturi

The external air pressure input line is on the right of the unit. This air is provided to the four regulators
and flows to the left to the hose for the Syringe Clamp Slide Solenoid Valve. The Syringe #1 & #2
regulators provide reduced air pressure to the Syringe #1 & #2 Solenoid Valves. The Syringe #1 & #2
VAC regulators provided reduced air pressure to the Syringe #1 & #2 Venturi components. The Venturi
units convert the positive air pressure into a vacuum that is provided to the negative side of the Syringe
#1 & #2 Solenoid Valves.
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Dual Control Air Dispenser Electrical Connections

The Dual Control Air Dispenser requires a number of electrical connections for the proper operation of
this unit. These interfaces include the following:

e Three 24VDC input signals into the Air Dispenser that operate the three solenoid
values (Syringe #1 & #2 Valves and the Syringe Clamp Slide Valve).

e Three dry contacts in the Air Dispenser that indicate if any of the buttons is being
pressed (Red Free, Green Line and Blue Arc momentary contact buttons).

e Three 24VDC input signals into the Air Dispenser that turn on the back lights of
the three buttons.

¢ One sensor output signal from the Air Dispenser that is generated by the Z-
Contact sensor on the Sliding Syringe Clamp.

All of these signals are connected to 4-pin 3M 37104 series Mini-Clamp Plugs.

- Pin1

The following tables describe how each of the signals are wired to their respective plugs.

Pin Push Button with Back Light Wire Color
1 GND Black
2 24VDC supplied to turn on back light. Returned through pin 1. Gray
3 24VDC returned by dry contact switch when button pressed. Green
4 24VDC power supplied to dry contact switch. Red
Pin Solenoid Valve Control Wire Color
1 GND Black
2 24VDC supplied to open valve. Returned through pin 1. Red
3 N.A. Not connected
4 N.A. Not connected
Pin Z-Contact Sensor Wire Color
1 GND Blue
N.A. Not connected
3 24VDC returned by sensor when contact detected. Black

Copyright © 2022, Brooks Automation, Inc. 101



Reference Information Guidance Dispense System
P/N: GDPO-DI-S0010, Rev 5.0.0, April 9, 2022

4 24VDC power supplied to sensor. Brown

Interfacing to PrecisePlace Robots

If the Dual Control Air Dispenser is interfaced to a PrecisePlace robot, the electrical connections from the
Dispenser should be plugged into the Digital I/0O signals provided in the Z-Axis 10 board. This board is
mounted beneath the cover for the Z-axis motor. The following is a picture of the Z=Axis 10 board.

DANGER: The Z-Axis IO board contains an optional motor connector

that provides a bus voltage of 320 VDC. As such, this board
represents a high-risk and should only be accessed when the main

AC power to the robot is disconnected.

The following table defines where each of the Air Dispenser plugs should be connected to the Z-Axis |10
board.

DI1O Connector GPL Signal Number Air Dispenser Plug
1 33/10033 Red Free button
2 34/10034 Green Line Button
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3 35/10035 Blue Arc Button

4 36 Syringe Clamp Slide Solenoid Valve
5 37 Syringe #1 Valve

6 38 Syringe #2 Valve

7 10039 Z-Contact Sensor

8 No used
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Trouble Shooting Guide

Guidance Dispense Common Error Messages

The following table contains common error messages and pop-up messages that you may encounter
during the normal operation of the Guidance Dispense system. Please see the Precise Documentation
Library > Controller Software > Software Reference > System Error Codes for a description of the
complete list of error messages that can be generated by the robot control system.

Error

Description

Corrective Action

Error Messages

-1006, *Robot
already
attached*

Can occur when trying to record a
position that requires that the
dispensing head dimenions be set but
another task has control of the robot.

The most common problem is that the virtual MCP
is not in Computer mode and is controlling the
robot. Be sure to set the virtual MCP to computer
mode.

-1046, *Power
not enabled*

Can occur any time in response to a
request to execute a dispensing
Process, Path, Move Safe, Retract
Arm or other robot motion.

Before the robot can be moved, motor power must
be enabled. Check that the "System state:"
displays "GPL ready" before attempting to move
the robot.

-1047, *Virtual
MCP in Jog
mode*

Can occur any time in response to a
request to execute a dispensing
Process, Path, Move Safe, Retract
Arm or other automatic robot motion.

The system cannot be in jog mode when
attempting to move the robot automatically. Take
the system out of jog mode by clicking on the
"Comp" button in the "Robot Status" under "Edit" or
the "Computer" button in the Virtual Pendant.

-4000,
*Cannot
connect to
\vision server*

Can occur in response to a request to
execute a dispensing Process or Path
that uses PreciseVision to locate an
object.

Before a vision process can be executed,
PreciseVision must be running on a PC. The PC IP
address must be set in the "Vision Configuration”

page.

\Vision
Operation
Failed

During execution of a dispensing
Process that contains a request to
locate an object using PreciseVision,
the PreciseVision process has failed
due to one of its vision tools not
obtaining the expected results.

Check the PreciseVision camera window to see if
the proper object is inside the field of view.

Check to see if the proper PreciseVision project is
loaded for the dispensing Path being executed.

Check to make sure the proper lighting is set and
on.

Pop up messages

This indicates that the web interface is still

Last Message occurs when clicking on a  |processing the last request while a new one is
Command button or selecting an item in a listin  |being requested. Only a single request can be

Still Busy ... [the graphical user interface. performed at a time in the web interface.
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Trouble Shooting Guide

Try performing the operation again.

If this continues to happen for all requests and the
robot is idle, make sure the GPL project is loaded
and running. See the Precise Documentation
Library for details on the Guidance Web Interface.
Use the Guidance Web interface operator control
panel to determine if the "GDispense" project is
loaded and running.

Changing
points too
quickly.

Message occurs when selecting points
in the path editor.

\When a Path node is selected, the web page
retrieves the information from the controller and
updates the data fields. This operation cannot be
interrupted and must be completed.

If this message continues to be displayed, try
slowing down between selection of points. If the
web pages seem to be updating very slowly, check
with your network administrator as there could be a
problem with the network traffic.

Busy ...

Message never goes away at bottom
of web panels.

\While the robot is executing a Process or Path,
the "Busy ..." indicator will be displayed.

If the indicator never goes away, it could indicate
that the GPL project "GDispense" is not executing.
See the Precise Documentation Library for details
on the Guidance Web Interface. Use the Guidance
Operator Control panel to determine of the
"GDispense" GPL project is executing.
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